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Introduction  

Thank you for purchasing MileMaker® SP32. MileMaker is the most widely used 
and accepted mileage and routing system in the transportation industry, and the only 
computerized version of the Household Goods Mileage Guide (HHG)—the industry 
standard for determining highway mileages. 

As soon as you install MileMaker, you can use it immediately to: 

• Retrieve precise HHG mileages. 

• Simplify rate negotiations. 

• Determine cost effective Practical Routes. 

• Reduce audit disputes. 

• Determine driver payroll. 

• Report fuel taxes. 

• Verify out-of-route miles. 

• Facilitate dispatching. 

• Estimate time of arrival. 

You can use MileMaker with confidence because the system provides consistent 
mileages time after time, regardless of the number of stop-offs or the remoteness of 
the destination. This unparalleled consistency is the result of MileMaker’s extensive 
and precise database, containing a record of every segment of state, provincial, 
federal, and interstate highway in the United States, Canada, Mexico and Puerto 
Rico. 
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System Requirements 

Windows Stand-Alone 

To run MileMaker SP32 on a Windows Stand-Alone system, you will need: 

• Windows® Vista Business, Windows® 2003 server or Windows® XP SP2.  

• 32 MB of RAM. 

• 60 MB of available hard drive space. 

• CD drive 

Local Area Network (LAN) 

To run MileMaker SP32 on a LAN system, you will need: 

• Windows® 2003 Server, Windows® Vista Business, or Windows® XP SP2 

• 64 MB of RAM. 

• 60 MB of available hard drive space. 

• CD drive 

Installation Instructions 

Installing MileMaker SP32  

The MileMaker SP32 installation retains the current MileMaker SP32 settings 
during the update process. 

1. Place the MileMaker SP32 CD in the CD-ROM drive. 

2. Terminate any active programs running on the system. 

3. On the taskbar, click the Start button and then click Run. 

4. In the Run dialog box, type D:\setup, where D: represents the letter of your 
CD-ROM drive and click OK. 

5. Follow the on screen prompts to complete the installation. 
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Once the installation is complete, you will not need the CD-ROM to run MileMaker 
SP32. 

Installing the MileMaker SP32 Excel Add-In  

The MileMaker SP32 Excel add-in, mmexcel.xla, adds optional commands and 
features to Microsoft Excel for use with MileMaker SP32. To install this add-in, 
follow the process detailed below. 

MileMaker SP32 must be installed before proceeding. Note: 

Step 1 - Install and Load the Excel Add-In 

This step installs the MileMaker SP32 Excel add-in, mmexcel.xla. Once installed in 
Excel, this add-in is referred to as the mmexcel add-in. 

 To install and load the Excel add-in: 

1. Start Microsoft Excel.  

2. On the Tools menu, click Add-Ins. The Add-Ins dialog box appears. 

3. Click Browse, and then locate the add-in. 
The add-in is located in the c:\program files\rand mcnally\mmaker32\excel\ 
folder. 

4. Select the file mmexcel.xla in the folder described in the previous step, then 
click OK. The mmexcel add-in appears in the Add-Ins available box. 

5. In the Add-Ins available box, make sure the mmexcel check box is selected, and 
then click OK. 
The MileMaker SP32 Excel add-in is now ready for use. 

Step 2 - Register the Excel Add-In OCX Control Manually 

In the event that the Excel add-in is still not functioning properly, you may need to 
register the Excel add-in OCX manually.   

To register the Excel add-in OCX control: 

1. Exit Excel. 

2. Click Start, and then click Run. The Run dialog box appears. 
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3. In the Open box, type  

regsvr32 “c:\program files\rand mcnally\mmaker32\bin\IntelliTextExcelSA.ocx”  

and then click OK.  

If you did not take the default installation location, please replace the c:\program 
files\rand mcnally in the command above, with the location that you used to install 
the MileMaker product. 

Note: 

A window will appear indicating that the IntelliTextExcelSA.ocx has been 
registered successfully. 

4. Click the OK button and restart Excel again. 
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Using Rand McNally Motor Carriers' Road Atlas with 
MileMaker SP32  

When MileMaker SP32 generates a route, it includes helpful references to page 
numbers and coordinates in the Rand McNally Motor Carriers' Road Atlas. To view 
these references, select Map/View/Itinerary only. This forces the Itinerary to fill the 
MileMaker workspace. The furthest column to the right is titled "Motor Carriers' 
Key." The entries in this column refer to page numbers and page coordinates for 
each leg of the route. 

 The Motor Carriers' Key column can also be displayed by: 

• Dragging the center bar that splits the Map View and Itinerary View to the 
right with the cursor 

or 

• Using the Itinerary View scroll bar to scroll the itinerary view to the right. 

Motor Carrier Reference keys can also be viewed from the map for most locations. 
This can be useful when providing a driver directions over the phone. 

 To view reference keys from the map: 

• Select Show Locations on the tool bar and enter location 

or 

• Click on the location using the mouse and then click on the Show Locations 
tool bar. 

Using Latitude and Longitude Inputs with MileMaker 
SP32 

Numeric values for latitude and longitude can be used as input coordinates for 
MileMaker SP32. 

 To view locations with latitude and longitude inputs: 

1. Select Show Location in the MileMaker SP32 toolbar. 

2. Make sure your cursor is located in the Locations entry field. 

3. Type your latitude and longitude pair using up to six decimal places separated 
by a space. For example: 38.67 90.25 
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4. Select Show. Your map view will now display the location with a label 
designating the point on the map. 

You can also use latitude and longitude point pairs in the creation of practical 
routes. 

 To use latitude and longitude points as pairs in routing: 

1. Select Practical Route. 

2. In the Locations entry field, type in the latitude and longitude point pair. The 
latitude value must be first, followed by a space and the longitude value, and 
both should be up to six decimal places. For example: 38.67 90.25 

3. An entry will appear in the locations validation box. Select the top entry and 
choose Add to move that location into the list of routable points. 

4. If a point is not found, a browse screen will be displayed. 

5. Continue until all desired routable points have been added. 

6. Select Calculate. MileMaker will then display a map and itinerary. 
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Integrating MileMaker on Your LAN or with Other 
Applications 

There are two basic methods for integrating MileMaker SP32 into your applications 
or enterprise environment: 

1. Dynamic Link Library (DLL) - this is a programming interface specification 
that allows you to write applications that request mileage and routing lookups 
(see the MileMaker DLL Technical Reference Guide for details). 

2. Local Area Network (LAN) - this allows MileMaker SP32 to operate over a 
LAN (refer to MileMaker LAN technical guide for more information). 

Both options may require additional licensing arrangements. Please contact your 
sales representative for more information. 

Technical Support 

Telephone support is available at Rand McNally & Company Technical Support at 
(800) 234-4069 Monday through Friday between 8 a.m. and 5 p.m. CST. 
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Introduction 

This chapter describes the different types of route and mileage inquiries available in 
MileMaker SP32. 

To select an inquiry in MileMaker you must know: 

1. Whether you want to process your inquiry using HHG rules or Practical 
Routing. 

2. Whether you want to produce a mileage inquiry or a route inquiry. 

HHG and Practical Inquiries 

HHG Inquiries 

When you process an HHG inquiry, MileMaker determines the shortest distance 
between any two locations over truck-usable roads, based on the most current 
version of the Household Goods Mileage Guide (HHG). All HHG inquiries give 
you HHG Tariff Mileages, which are used universally for freight rating and 
auditing. 

The MileMaker database incorporates all of the complex HHG rules that affect 
route determination and uses only those highways, bridges, and ferries designated as 
truck authorized by the Household Goods Mileage Guide (HHG). 

Routes derived from this feature generally incorporate highways from the Surface 
Transportation Assistance Act (“STAA”) and the National Highway System 
(“NHS”) networks.  However, not all locations can be accessed on the STAA 
network.  Therefore, in some cases your route results may contain non-STAA 
highways. 

Note: 

Practical Inquiries 

When you select a practical inquiry, MileMaker calculates the most time- and fuel-
efficient route between the locations entered. Practical Routes are not calculated 
with HHG tariff rules. The Practical Route State Mileage Breakdown mileages are 
acceptable for fuel tax reporting and dispatching, driver payroll, verification of out-
of-route miles, and estimating time of arrival. 
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Mileage Inquiries 

A mileage inquiry produces a report that shows the number of miles between the 
locations you have entered into MileMaker. You can select three different mileage 
inquiries in MileMaker: the HHG Standard Mileage Inquiry, the HHG Origin to 
Multiple Destinations Inquiry, and the Practical Mileage Inquiry. 

HHG Standard Mileage Inquiry 

The HHG Standard Mileage Inquiry provides mileages between sequentially 
entered pairs of locations. The returned mileage is the shortest using HHG rules and 
approved truck-usable roadways. 

 

Figure 2-1: Sample 
output from HHG 
Standard Mileage Inquiry 

 To select an HHG Standard Mileage Inquiry: 

• On the toolbar, click HHG Mileage.  

or 

• On the Mileages menu, select HHG Mileage. 

HHG Origin to Multiple Destinations Inquiry 

The HHG Origin to Multiple Destinations Inquiry provides mileages between a 
single origin and multiple destinations. The returned mileage is the shortest using 
HHG rules and approved truck- usable roadways. 

 

Figure 2-2: Sample 
output from HHG Origin 
to Multiple Destinations 
Mileage Inquiry 

 To select an HHG Origin to Multiple Destinations Mileage Inquiry: 

• On the toolbar, click HHG Origin.  

or 
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• On the Mileages menu, select HHG Origin. 

If you are executing either of the above HHG mileage inquiries, you can specify 
whether MileMaker should return a zero mileage or an error message when the 
same location is entered as both the origin and destination. For details, see 
Customizing an HHG Mileage Inquiry on page 29. 

Note: 

Practical Mileage Inquiry 

The Practical Mileage Inquiry provides Practical Route mileages between 
sequentially entered pairs of locations. The returned mileage reflects the most time- 
and fuel-efficient route. 

 

Figure 2-3: Sample 
output from Practical 
Mileage Inquiry 

 To select a Practical Mileage Inquiry: 

• On the Mileages menu select Practical Mileage 

Route Inquiries 

A route inquiry produces a report with detailed route information. A route inquiry 
can also provide a State Mileage Breakdown, which shows the shortest distance 
traveled in each state along the specified route. You can select six different route 
inquiries in MileMaker. There are three Practical Route inquiries: the Practical 
Route Inquiry, the Practical Route with State Mileage Breakdown Inquiry, and the 
Practical Route—State Mileage Breakdown Only Inquiry. There are also three HHG 
route inquiries: the HHG Audit Route Inquiry, the HHG Full Route with State 
Mileage Breakdown Inquiry, and the HHG Route—State Mileage Breakdown Only 
Inquiry. 

 

Practical Route Inquiry 

The Practical Route Inquiry provides detailed information on the most time- and 
fuel-efficient route between the locations entered. A Practical Route can be 
calculated in miles or kilometers. 
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 To select a Practical Route Inquiry: 

• On the toolbar, click Practical Route, or on the Routes menu, select Practical 
Route. 

The output from a Practical Route inquiry will look like the output shown in Figure 
2-4, but without the State Mileage Breakdown information displayed the lower left 
list box. 

Practical Route with State Mileage Breakdown (SMB) Inquiry  

The Practical Route with State Mileage Breakdown Inquiry provides the Practical 
Route along with State Mileage Breakdown information. 
 

  

Figure 2-4: Output from 
Practical Route with 
State Mileage 
Breakdown Inquiry 

The Practical Route displays the highway name, road direction, total miles traveled 
on the road, the location, accumulated time, and miles for the locations entered. The 
State Mileage Breakdown appears below the Practical Route. 

 To select a Practical Route with State Mileage Breakdown Inquiry: 

• Press Practical Route w/SMB on the toolbar or on the Routes menu, select 
Practical Route w/SMB. 
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Practical Route—State Mileage Breakdown Only Inquiry 

The Practical Route—State Mileage Breakdown Only Inquiry displays the distance 
traveled in each state along the practical route. 

 To select a Practical Route—State Mileage Breakdown Only Inquiry: 

• On the Routes menu select Practical Route SMB only 

• The output from a Practical Route—State Mileage Breakdown Only Inquiry 
will look like the output shown in Figure 2-4, but will show only the State 
Mileage Breakdown information displayed in the lower left list box. 

HHG Route Inquiries 

HHG Audit Route Inquiry 

The HHG Audit Route displays mileages between key point to key point cities used 
in the route. Predetermined key point distances are listed in the mileage chart of the 
Household Goods Mileage Guide (HHG). The HHG Audit Route also shows the 
actual roads used, the direction traveled, and the number of miles on each road 
between key points and non-key points. If both points in a request are key points, 
only the mileage will be displayed. 
 

Figure 2-5: Sample 
Output from an HHG 
Audit Route Inquiry 

 

 To select an HHG Audit Route Inquiry: 

• On the Routes menu select HHG Audit Route 

HHG Full Route with State Mileage Breakdown Inquiry 

The HHG Full Route with State Mileage Breakdown Inquiry provides the shortest 
distance route between two points (calculated in accordance with the rules of the 
Household Goods Mileage Guide (HHG)) along with a breakdown of the distance 
traveled in each state. 
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Figure 2-6: Sample 
Output from HHG Full 
Route with State Mileage 
Breakdown Inquiry 

Each route displays the highway name, road direction, the number of miles on each 
segment of road, nearest junction or city name, cumulative miles traveled, and the 
road characteristics. 

 To select an HHG Full Route with State Mileage Breakdown Inquiry: 

• On the Routes menu select HHG Full Route w/ SMB 

HHG Route—State Mileage Breakdown Only Inquiry 

The HHG Route—State Mileage Breakdown Only Inquiry provides the shortest 
distance between points, but displays only a state-by-state listing of the distance 
traveled in each state. Miles are categorized as toll and non-toll.  

 To select an HHG Route—State Mileage Breakdown Only Inquiry: 

• On the Routes menu select HHG Route SMB Only 

The output from a HHG Route—State Mileage Breakdown Only Inquiry will look 
like the output shown in Figure 2-6, but will show only the State Mileage 
Breakdown information displayed in the lower list box. 
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Introduction 

Whichever type of MileMaker inquiry you select, the basic procedure for entering 
the inquiry into MileMaker is the same. To run the inquiry, you must follow these 
basic steps: 

1. Open one of the inquiry dialog boxes by clicking one of the buttons on the 
toolbar or selecting an inquiry from the Mileages or Routes menu. 

2. Enter a route list specifying the locations along your route, following the 
instructions in this chapter. 

3. Add any of the customization options available for the selected inquiry, also 
described in this chapter. 

4. Press the Calculate button in the dialog box to process your inquiry. 

It is possible to enter locations for an inquiry directly on the map. For more 
information, see chapter 5, "Working with the Map." 

Note: 

18 Chapter 3 - Entering an Inquiry 



 

Entering a Route List into MileMaker 

When you open one of the inquiry dialog boxes in MileMaker, it will have a section 
like the one shown in Figure 3-1. You will use this section to enter the locations 
along your route. 
 

 

Figure 3-1: Location 
entry fields 

"Location" is a general term that describes an origin, stop-off, or destination. Note: 

 To enter locations along a route: 

1. In the Locations field, enter your origin. Enter a city name, followed by a state 
or province code, with no space between the comma after the city name and 
the code that follows. Spaces are only used to separate city names that contain 
more than one word, as illustrated in Figure 3-1. 

2. You can also enter a truckstop, a junction, an SPLC, or a ZIP Code as a 
location. For details on how to enter each type of location, see Specifying 
Locations in the Route List on page 21. 

When you finish entering a city and state or province code, that city should 
automatically appear in the list box below the Locations field. If it does not, check 
to make certain that you have spelled the name and the code correctly and that there 
is no space between the state code and the comma that precedes it. 

Note: 

If there are two cities with the same name in the same state, they will appear in the 
list box with a county code. Make sure that the correct city is highlighted before 
adding it to your route list. 

3. When the location you want appears, highlighted, in the list box below the 
Locations field, click the Add button. The location will appear in the list box on 
the right.  

After typing in a location, pressing the Enter key will also add the location to your 
route list. 

Note: 
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4. After you add the location to your route list, the name in the Locations field is 
highlighted, as shown in Figure 3-2. Simply type your next location over this 
one; the new entry will automatically replace the highlighted one. 

 

 

Figure 3-2 

5. Continue to enter locations until all of the locations along your route appear in 
the route list. MileMaker will assume that the first location in the route list is 
your origin, the last location is your destination, and those in between are 
stopovers, unless you have selected the HHG Origin to Multiple Destination 
Inquiry (see page 11) or have checked one of the route optimization options 
(see page 23). 

If you type a complete location name (for example, a name, a comma and a state 
code or a five-digit ZIP Code) and MileMaker cannot match a specific location to it, 
a browse list appears in the Locations list box. You can search this list for the 
correct location, select it, and then Add the location to your route list. If you do not 
find the location in the list, check to make sure you have typed in the location name 
correctly. 

Note: 

6. Once you have entered your list of locations, you can: 

• Insert a location anywhere in your route list (see page 23). 

• Delete a location from your route list (see page 23). 

• Optimize your route list (see page 23). 

• Save the route list with a unique name so you can re-enter the list quickly 
at any time (see page 25). 

• If you are entering a Practical Route Inquiry, you can customize your 
inquiry in a variety of ways (see page 31). 

7. When your route list and any customization options are completely specified, 
press the Calculate button that appears in the inquiry dialog box to process the 
inquiry. 
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When you press the Calculate button, a transaction is deducted for each point-to-
point calculation in your inquiry. For example, the sample route from Chicago to 
Daytona Beach to Garland would count as two transactions. Be sure to press the 
Calculate button only when your inquiry is completely specified. For more 
information about monitoring and adding transactions, see chapter 6. 

Note: 

8. After processing your inquiry you can press the Clear button to clear the route 
list and enter a new list of locations, or you can click the Close button (the 
small "x" in the upper right hand corner of the dialog box) to exit the dialog 
box. 

 

Specifying Locations in the Route List 

You can enter locations into MileMaker using any of the following methods, in any 
combination. 

• Enter a city name and a state or province code, with no space after the comma. 
Example: New Orleans,LA 

• Enter a truck-stop name and state code, with no space after the comma. 
Example: Brooke Sunoco Plz,IA 

• Enter a junction, with highway names separated by a slash and no space after 
the comma. Use the abbreviations shown below. This method is valid for 
Practical Routes only. 
Example: I55/I94,IL  

 

I (Interstate Highway) U (U.S. highway) 

S (State highway) P (Provincial or TransCanada highway) 

F (Mexican Federal highway) C (County highway) 

O (Other roadway such as local road)  

• Enter locations by SPLC (Standard Point Location Code). 
Example: 380000 

This method is necessary to process military locations in the manner 
acceptable to the Department of Defense. 

• Enter a 5-digit U.S. ZIP Code. This method is valid for HHG inquiries only. 
Example: 60620  

• Large metropolitan areas may have multiple ZIP Codes. For example, 
60601 and 60610 will access the same point in Chicago for mileage 
calculation.  
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• A single ZIP Code may include multiple locations. In such case, a browse 
list will appear with location choices. Alternatively, you can request that 
MileMaker use a default location, as described below. 

When multiple locations are tied to a ZIP Code, ZIP Codes displayed in the browse 
list may be prefaced by “*”. An “*” indicates that the ZIP Code is used as a default 
for both HHG and Practical mileage requests.  

Note: 

 To use default locations for multiple-location ZIP Codes: 

1. On the Features menu, select Route Processing Options 

2. In the ZIP Code Processing section of the Router Processing Options dialog 
box, select Use Default ZIP Codes. 

3. Click OK. 

 

Figure 3-3 

MileMaker will continue to use default ZIP Codes for multiple-location ZIP Codes 
in the current and future sessions unless you change this option again. You can do 
so by: 

• Returning to the Router Processing Options dialog box and selecting the Do 
Not Use Default ZIP Codes option. 

or 

• Selecting the Reset to Do Not Use at Startup option. When you select this 
option, MileMaker will use default ZIP Codes for the remainder of the current 
session, but will return to the default method of displaying the Browse list the 
next time you start MileMaker. 
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Modifying the Route List 

Once you have entered a list of locations you can modify the list by: 

• Inserting locations into the list. 

• Deleting locations from the list. 

• Optimizing the locations in the list. 

• Saving the list under a user-specified name. 

Inserting Locations into the Route List 

 To insert a location into the route list: 

1. Add the location to the route list, as described in the previous section. 

2. Click once on the location you have added to select it, then click a second time 
and continue to hold the mouse button down. 

3. While holding the mouse button down, drag the location to the correct place in 
the route list. 

Deleting Locations from the Route List 

 To delete a location from the route list: 

• Click on the location to select it, then click the Delete button or double click on 
the location. A dialog box will open asking if you want to delete the selected 
item. 

Optimizing the Route List 

You can have MileMaker optimize your route list by selecting one of the Optimize 
options in the inquiry dialog box.  
 

 

Figure 3-4: Optimize 
Options 

When you have selected a Practical Route, optimizing the route list will reorder 
your locations so that the route will be the most logical from a geographic 
perspective. When you have selected an HHG Audit Route or HHG Full Route, 

MileMaker SP32 User Guide 23 



 

optimizing will reorder your locations to determine the route with the overall 
shortest distance.  

 To optimize a route list with no predetermined destination: 

1. After entering your list of locations, click on the Optimize check box so that a 
check mark appears. Note that this option becomes available only after you 
have entered three or more locations into your route list.  

2. Click on Calculate. The following message may appear: "You have chosen 
Optimized Routing as your preference. Stopovers may be reordered if you 
proceed with routing. Do you want to continue?" Click on OK if you want to 
continue. Click on Cancel if you do not want MileMaker to reorder your 
stopovers. 

3. After the calculation is finished, the following message may appear: 
"Optimized Routing caused your locations to be reordered." Click on OK to 
continue. 

 

 To optimize a route list with a specified destination: 

1. If you want MileMaker to use a specific location as the destination when 
optimizing the route list, click on the Optimize with specific destination check 
box. This option only becomes available after you have first checked the 
Optimize option.  

2. In the route list, select the location that you want to designate as the 
destination. 

3. Click on the Destination button. A “D” will appear next to the destination 
location. 

4. Click on Calculate. The following message may appear: "You have chosen 
Optimized Routing as your preference. Stopovers may be reordered if you 
proceed with routing. Do you want to continue?" Click on OK if you want to 
continue. Click on Cancel if you do not want MileMaker to reorder your 
stopovers. 

5. After the calculation has been completed, the following message may appear: 
"Optimized Routing caused your locations to be reordered." Click on OK to 
continue. 
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Saving the Route List Under a User-Specified Name 

If you use a particular route list frequently, it is inconvenient to re-enter the list of 
locations each time you want to run an inquiry. You can use the Custom Name 
feature in MileMaker to save a route list under a name you specify. When you enter 
this name in the Locations field (see Figure 3-5), the entire list of locations saved 
under that name will appear in the list box below. Once you have saved a Renamed 
Location, you can edit or delete it at any time by choosing Renamed Location(s) on 
the Features menu. 
 

 

Figure 3-5: Using a 
Renamed Location to 
enter a route list 

 To save a route list as a Renamed Location: 

1. Enter the list of locations you want to save. 

2. Click the Rename Location(s) button.  

3. In the Add Custon Name dialog box, enter the name under which you want to 
save the route list, as shown in Figure 3-6. The name you provide must be at 
least four characters long. 

 
Figure 3-6 
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Do not use 5-, 6-, or 9-digit numbers for Renamed Location. Doing so interferes 
with entering locations by ZIP Code or SPLC. You may use a combination of letters 
and numbers in the name as long as the name begins with a letter, for example: 
PAT12. 

Note: 

4. If you wish, modify the list using standard location entry procedures. 

5. Click on OK. 
 

You can go directly to the Custom Name Manager dialog box to enter and save a 
route list by selecting Renamed Location(s) on the Features menu. 

Note: 

 

Network Users: All users on a network share a single list of Renamed Locations. 
Before changing or deleting a Renamed Location in the list on the network, it is 
important to consult with other users. 

Note: 

 To retrieve a route list using a Renamed Location: 

1. In the inquiry dialog box Locations field, enter a Renamed Location. The list of 
locations will appear in the list box below.  

2. Click the Add button to add the Renamed Location list to your route list. 

You can add additional locations to the route list at this point. This will not alter the 
Renamed Location list unless you press the Rename Location(s) button and create a 
new Renamed Location. 

Note: 

 To Insert, Edit, or Delete a Renamed Location: 

1. On the Features menu, select Renamed Location(s).  

2. The Custom Name Manager dialog box will appear with a list of the Renamed 
Locations you have created, as shown below. 

 

 

Figure 3-7 

26 Chapter 3 - Entering an Inquiry 



 

3. In this dialog box you can use the following buttons: 

New 

Opens the Rename Location(s) dialog box, where you can create a new 
Renamed Location.  

Change 

Opens the Change Location Name(s) dialog box, which displays the route list 
for the selected Renamed Location. You can edit and save the list. 

Delete 

Deletes the selected Renamed Location. 

Print 

Prints the selected Renamed Location to the default printer. 

Done 

Saves any changes and exits the Custom Name Manager dialog box. 

Help 

Provides instructions for this dialog box. 

Changing the Inquiry Type 

You may wish to perform several different inquiries for a single route list. If so, you 
do not need to re-enter the route list each time, you can change the inquiry type 
from within an inquiry dialog box, retaining the route list you already entered. 

Each time you calculate a new inquiry for a route list, a new set of transactions is 
deducted from your total. 

Note: 

Changing Inquiries from the Mileage Inquiry Dialog Box 

You can switch to a different inquiry from the HHG Mileage Inquiry and the HHG 
Origin to Multiple Destination Inquiry in the following ways: 

• To switch between the HHG Mileage Inquiry and the HHG Origin to Multiple 
Destination Inquiry click on a selection in the Inquiry Type section of the dialog 
box (see Figure 3-8 below). 

• To submit a Practical Route inquiry for the same route list, click the Routes 
button.  
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• You will also have the opportunity to create a Practical Route for the route list 
when you exit one of the HHG Mileage Inquiry dialog boxes. When you click 
the Done button or the Close button in the upper right hand corner of the dialog 
box, the Practical Route dialog box automatically appears. If you do not wish 
to create a Practical Route for the route list, you can just Cancel this dialog 
box. 

 

Figure 3-8 

The Practical Mileage dialog box looks the same as the HHG Mileage dialog boxes, 
except that the Inquiry Type section of the dialog box is unavailable.  

• From the Practical Mileage dialog box you can click the Routes button to 
create a Practical Route with the current route list.  

• The Practical Route dialog box will not appear when you exit the Practical 
Mileage Inquiry dialog box. 

Changing Inquiries from the Route Dialog Boxes 

You can switch between the Practical Route Inquiry, the Practical Route with State 
Mileage Breakdown Inquiry and the Practical Route—State Mileage Breakdown 
Only Inquiry using the selections in the Inquiry Type section of the Practical Route 
Inquiry dialog box (see Figure 3-9).  

You can also change to an HHG Route Inquiry by selecting HHG Route in the 
Inquiry Type drop-down list. 
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Figure 3-9: Inquiry Type 
section from the Practical 
Route Inquiry dialog box 

Similarly, in the HHG Route Inquiry dialog box you can switch between the HHG 
Audit Route inquiry, the HHG Full Route with State Mileage Breakdown inquiry 
and the HHG Route - State Mileage Breakdown Only inquiry (see Figure 3-10). Or, 
you can switch to a Practical Route inquiry by selecting Practical Route in the drop-
down list. 
 

 

Figure 3-10: Inquiry 
Type section from the 
HHG Route Inquiry 
dialog box 

Customizing an HHG Mileage Inquiry 

For an HHG Standard Mileage Inquiry or an HHG Origin to Multiple Destinations 
Inquiry, you can use the Zero Miles Processing option to specify whether 
MileMaker will return a zero mileage or an error message when the same location is 
entered as both the origin and destination. The setting on this option will apply to 
these types of inquiries whether they are executed interactively or in batch mode. 

 To specify the Zero Miles Processing option: 

1. On the Features menu, select Zero Miles Processing. 
 

 

Figure 3-11 

2. In the Zero Miles Processing dialog box, select the Zero Miles Processing On 
option if you want MileMaker to return a zero mileage when the same location 
is entered as both the origin and destination. Select Zero Miles Processing Off if 
you want MileMaker to return an error message indicating that the request 
could not be processed. 

3. Click on Done to save any changes and exit the dialog box. 
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The MileMaker default for Zero Miles Processing is Zero Miles Processing Off. The 
current status of the Zero Miles Processing option is displayed at the bottom of the 
screen as “ON” or “OFF”. 
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Customizing a Practical Route Inquiry 

You can customize a Practical Route Inquiry in the following ways: 

• Calculate the route in kilometers instead of miles. 

• Alter the amount of toll road usage in the route. 

• Turn Green Band restrictions on and off. 

• Turn Canadian border restrictions on and off. 

Calculating a Practical Route in Kilometers 

To calculate a Practical Route in kilometers, select Kilometers in the Distance Units 
section as shown in Figure 3-12, below. 
 

 

Figure 3-12: Kilometers 
selected for Practical 
Route 

Altering Toll Road Usage in Practical Route Inquiries 

You can change the amount of toll road usage in your Practical Route Inquiry by 
changing the percentage in the Toll road bias section of the inquiry dialog box (see 
Figure 3-12). An increase in the percentage of toll road bias indicates that toll roads 
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should be avoided as often as possible in a specific route. A decrease in the 
percentage indicates that toll roads should not be avoided in a specific route.  

Your route may be affected when you change the toll bias setting. For example, 
there may be an increase in the mileage and/or travel time. 

Note: 

 To change the toll road bias in a Practical Route Inquiry: 

1. In the Toll road bias section of the Practical Route Inquiry dialog box, click the 
Change button. 

2. In the Toll Road Bias dialog box, enter a new bias number or use the scroll 
arrows to increase or decrease the bias. A 0 indicates no toll road avoidance 
and 100 indicates full toll road avoidance.  

 

 

Figure 3-13 

3. Click OK to accept the changed settings. This action will return you to the 
Practical Route Inquiry dialog box. The new setting will be used the next time 
you calculate your route. 

Note for Network Users: Toll Road Bias can be altered for individual users at each 
workstation. 

Note: 

Turning Green Band Restrictions On and Off 

The MileMaker Road Database includes Green Band Roads. Green Band Roads are 
those highways, which, for a variety of reasons, are not suitable for through truck 
travel. (Green Banded Roads are overprinted with a green band on the map pages in 
the Household Goods Mileage Guide (HHG), hence the name.) These roads may be 
restricted, i.e., green banded, because of physical restrictions, local ordinances, 
weather conditions, grade and other safety concerns, or other reasons. These roads 
are designated by each state.  

In MileMaker, the Green Band restriction is on by default; MileMaker will exclude 
roads that are restricted whenever a Practical Route is calculated. If you want a 
Practical Route for vehicles that are allowed to drive on Green Band-restricted 
roads, you can turn Green Band Restrictions off. 
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Warning: Turning Green Band Restrictions off may produce Practical Routes that 
do not conform to the Rand McNally standard for truck usable highways, and, as 
such, may deviate from highway segments which Rand McNally has defined as 
generally suitable for truck travel.  

Note: 

 To turn Green Band restrictions off: 

1. On the Features menu, select Route Processing Options. 

2. In the Green Band Restriction section of the Router Processing Options dialog 
box, select Turn Greenband Restriction Off (see Figure 3-14). 

3. Click OK. 
 

Figure 3-14: Green Band 
Restrictions turned off 

 
MileMaker will continue to have the Green Band Restriction turned off in the 
current and future sessions unless you change this option again. You can do so by: 

• Returning to the Router Processing Options dialog box and selecting the Turn 
Greenband Restriction On option. 

or 

• Selecting the Reset Greenband to On at Startup option. When you select this 
option, MileMaker will have Green Band Restrictions turned off for the 
remainder of the current session, but will return to the default restrictions the 
next time you start MileMaker. 
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 HHG Route inquiries and HHG Mileage inquiries are not affected by changing 
Green Band Restrictions, since HHG calculations are always done with Green Band 
Restrictions on. 

Note: 
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Turning Canadian Border Restrictions Off 

The Canadian Borders option enables you to cross the U.S./Canadian border in 
Practical Route calculations. By default, if an origin and destination are located in 
the same country, the Practical Route will be created only in that country, even if 
traversing a country border would make the route quicker and shorter. 

You can turn the Canadian Border Restriction off, thus allowing a Practical Route to 
cross over the Canadian border. 

 To turn the Canadian Border Restriction off: 

1. On the Features menu, select Route Processing Options. 

2. In the Canadian Borders section of the Router Processing Options dialog box, 
select Turn Canadian Border Restriction Off (see Figure 3-15). 

3. Click OK. 

 

Figure 3-15: Canadian 
border restriction turned 
off 

MileMaker will continue to cross country borders in Practical Route calculations in 
the current and future sessions unless you change this option again. You can do so 
by: 

• Returning to the Router Processing Options dialog box and selecting the Turn 
Canadian Border Restriction On option. 
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or 

• Selecting the Reset Restriction to On at Startup option. When you select this 
option, MileMaker will cross country borders in its calculations for the 
remainder of the current session, but will return to the default restriction the 
next time you start MileMaker. 

Setting the Newfoundland Abbreviation 

You can choose whether MileMaker® SP32 should use the abbreviation NL or NF to 
represent the Canadian province of Newfoundland and Labrador. 

 To specify the abbreviation used for the Canadian Province of Newfoundland and 
Labrador: 

In the Newfoundland Abbreviation area, click one of the following 

• NL to use the abbreviation NL for Canadian province Newfoundland and 
Labrador. 

• NF to use the abbreviation NF for Canadian province Newfoundland and 
Labrador. 

 

Figure 3-16: 
Newfoundland 
Abbreviation set to NF 
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Introduction 

Once you have generated mileage or route information in MileMaker, you can print 
the output directly to the printer or a file, or you can copy the information to the 
Windows clipboard to paste into another Windows application. 

Different methods are used to print and copy output from mileage inquiries and 
output from route inquiries. 

Printing and Copying Mileage Information 

You can print and copy output directly from the mileage inquiry dialog box (see 
Figure 4-1): 

• Click the Print button to send the output directly to your printer. 

• Click the Copy button to copy the output to the Windows clipboard. You can 
then paste the information into another Windows application. 

 

Figure 4-1 
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Printing and Copying Route Information 

 To print the output from route inquiries: 

1. Press Print on the toolbar or select Print from the File menu. 

2. In the Print dialog box (Figure 4-2), select the items you want to print. In the 
Print drop-down box you can select: 

• Current map to print just the map that displays your route or Route pack to print 
a packet of information including a summary page, an overview map page, and 
a set of pages showing segments of the itinerary with corresponding maps. 

 

 

Figure 4-2: Enter figure 
text here 

3. Specify the information in the Print Range section of the dialog box.  

4. Select the Print to File option if you want the output to go in a file rather than to 
the printer.  

5. Select the Collate Copies option if you are printing multiple copies of the 
output and want the pages to print in collated packs. If you do not check this 
option, MileMaker will print the specified number of each page before going 
on to print the next page. 

6. Click OK to print the output. 

 To copy information from route inquiries: 

• From the Edit menu, select Copy Map or Copy Itinerary, or select Copy All to 
copy both the map and itinerary to the clipboard. 
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Introduction 

With map graphics, you can: 

• Customize your view of the map and itinerary. 

• Zoom in to view specific areas on the map. 

• Find and label locations on the map. 

• Create a route inquiry directly on the map. 

• Avoid or prefer specific road segments in a route inquiry. 

• Print a copy of the map for reference. 

Viewing and Customizing the Map 

In this section you will learn how to view more of the map when the itinerary is 
open, how to obtain more information about the map, and how to customize the 
map's appearance. 

Moving the Itinerary Window 

After you process a route inquiry in MileMaker, you will see an itinerary on one 
side of the screen and the map on the other side. (See Figure 5-1). 
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Figure 5-1: Results of a 
route inquiry 

Current zoom level Splitter handle 

There are two ways to change the view of the map and itinerary: (1) you can drag 
the bar (also called the splitter handle) on the right side of the itinerary to the left or 
right, or (2) you can use the View option on the Map menu. 

• To drag the splitter handle, position your cursor over the bar that separates the 
itinerary and the map. The cursor will change appearance when it is correctly 
positioned. Then, while holding the mouse button down, drag the splitter 
handle to the left or the right until you have the view you want. 

• To change the view using the View option on the Map menu, use the following 
selections: 

Map Only 

Moves the splitter handle to the far left of your screen to hide the itinerary and 
display only the map in the active window. 

Itinerary Only 

Moves the splitter handle to the far right of your screen to hide the map and display 
only the itinerary in the active window. 

Map/Itinerary Split 

Restores the default display of the map on the right, the itinerary on the left, and the 
splitter handle down the middle. 

MileMaker SP32 User Guide 45 



 

Viewing the Map Scale and Map Legend 

On the Map menu, select Scale to turn the scale bar on and off. The scale bar shows 
you distances in miles relative to the zoom level of the current map view. 

On the Map menu, select Legend to turn the legend on and off. The legend tells you 
what the symbols on the map mean. 

Customizing the Map's Appearance 

On the Map menu, select Map elements to call up the Display Map Elements dialog 
box. This dialog box lists the items that are shown on MileMaker maps. By default, 
all items are turned on. You can deselect any item that you do not want to appear on 
the map. 

Moving around the Map 

There are several ways to zoom in and out on the map to see more or less map 
detail. There are also several methods for scrolling to different areas of the map. 

Zooming In and Out on the Map 

You can zoom in and out on the map by: 

• Using the rubber band zoom. 

• Using one of the zoom selections on the Map menu or one of the zoom buttons 
on the toolbar. 

• Using the zoom selection on a label’s drop-down menu. 

There are ten zoom levels in MileMaker. The current zoom level is displayed in the 
status bar at the lower right of the screen (see Figure 5-1). 

Using the Rubber Band Zoom 

To perform a rubber band zoom, click on the map and, holding the mouse button 
down, draw a rectangle around the area you wish to zoom in on. When you release 
the mouse button, the map will zoom in on the area you have defined. 

Using Menu Selections or Toolbar Buttons to Zoom 

To zoom in and out using selections on the Map menu, choose one of the following: 
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Zoom In 

Zooms in to the next scale level and increases the level of detail in the 
visible area of the map. The Zoom In button on the toolbar is a shortcut to 
this command.  
 

 

o this 

Zoom Out 

Zooms out to the next scale level and decreases the level of detail in the 
visible area of the map. The Zoom Out button on the toolbar is a shortcut to 
this command.  

Zoom Route 

Zooms in or out to display a complete view of the current route in the 
active window. The Zoom Route button on the toolbar is a shortcut t
command.  

Zoom Region  

Brings up the Zoom Region dialog box (see Figure 5-2). On the left, the list box 
contains regions and states in alphabetical order. Scroll through the list box and 
click on a preferred state or region. As you select a state or region, it becomes 
highlighted on the map in the dialog box. When you click on OK, the map in the 
active window zooms to the selected region. 
 

 

Figure 5-2 



 

Using the Map Label Drop-Down Menu to Zoom 

To zoom in on a specific location, you can click on that location on the map to 
display the map label (see figure 5-3). Then use your right mouse button to click on 
the label to display the drop-down menu. Select Zoom To to zoom in on the location. 

 

Scrolling the Map 

There are several ways to scroll the map in different directions. You can: 

• Use the scroll bars. 

• Use the compass. 

• Use the locator map. 

Scrolling with the Scroll Bars 

The scroll bars in MileMaker are standard Windows scroll bars. You can move the 
map by clicking on the arrows or by dragging the scroll box. 

Scrolling with the Compass 

 
You can turn the Compass on and off by selecting Compass Rose on the Map menu. 
When the Compass is turned on, you can click on any of the shaded areas within the 
Compass to scroll the map in that direction. The Compass is particularly effective to 
move the map diagonally. 
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Scrolling with the Locator Map 

 
You can turn the Locator Map on and off by selecting Locator Map on the Map 
menu. The rectangle on the locator map shows you the extent of your current map 
view. You can move about on the main map by dragging the rectangle in the locator 
map.  

You can reposition the Locator Map window by clicking on its title bar and 
dragging, or resize the window by dragging its borders. 

Note: 

Finding and Labeling Locations on the Map 

To find and label locations, you can: 

• Find and label locations with the Show Location dialog box.  

• Label locations directly on the map. 

Finding Locations with the Show Location Dialog Box.  

 To find a location: 

1. Click Show Location on the toolbar, or on the Map menu, select Show Location.  

2. In the Show Location dialog box (Figure 5-3), enter a location in the text box; 
the location name will appear, highlighted, in the list box below.  
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3. Click on the Show button. The map will center on the location, which will 
appear with a label. 

 
Figure 5-3 

 

You can make additional selections in the Show Location dialog box, as follows: 

Origin/Destination buttons 

If you have calculated a route, you can click on the Origin button or Destination 
button to find and label those locations on the map.  

Zoom in to this location 

The Zoom in to this location option causes the map to center and zoom on the 
selected location; it is checked by default. 

Open new window 

The Open new window option causes MileMaker to display the selected location in a 
new window. Use the selections on the Windows menu to view multiple windows.  

Display Map in Radius of 

Select this option to display a mileage/kilometer radius boundary around the 
selected location (base location). To use this option, select the Display Map in Radius 
of check box and specify the distance of the radius (number of miles or kilometers) 
from your base location. Click on the Show button to display the radius boundary. 

Other Ways to Open and Close Map Labels 

You can click on any location on the map to open its label. If there are multiple 
locations in the area you have clicked on, the Select a location dialog box will open 
for you to select the location you wish to label. To close a label, double click on it 
with your left mouse button. (Click once with your right mouse button to open the 
label's drop-down menu.)  
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When you calculate a route, the labels for the origin, destination and any stop-offs 
appear on the map automatically. To turn these labels off, as well as any other labels 
that are open on the map, select Label ∑ Hide All Labels from the Map menu. If you 
want to turn all of the labels for your route on, select Label ∑ Label route from the 
Map menu. 

Creating a Route Directly on the Map 

You can mark the origin, destination and stop-offs for a Practical Route directly on 
the map and then click the Calculate button on the toolbar to process the route. 
There are two ways to mark locations on the map: 

• Using the map label. 

• Using route markers. 

Using Map Labels to Mark Route Locations 

 

 To create a Practical Route using map labels: 

1. Label the origin of the route by using the Show Location dialog box or by 
clicking directly on the map. 

2. Click on the label with your right mouse button to open the drop-down menu. 

3. Select Set Origin on the drop-down menu to mark the route's origin. 

4. Repeat steps 1-3 to mark the destination and any stop-offs, using the Set 
Destination selection to mark the route's destination and the Add Location 
selection to mark any stop-offs. 

5. When all locations have been added to the route, click the Calculate button on 
the toolbar to process the route. 

Make sure that you have added all of your locations to the route before processing 
it; transactions are deducted each time you recalculate the route. 

Note: 
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Using Route Markers to Create a Route 

 To create a Practical Route using route markers: 

1. On the Map menu, select Route Markers to open the Route Markers window. 

 

2. To label the origin of the route, click on the marker labeled Orig and, holding 
the mouse button down, drag the marker to the route origin. 

It is easier to place the markers if you are zoomed in on the map. Note: 

3. Repeat steps 1-2 to mark the destination and any stop-offs, using the Dest 
marker to mark the route's destination and the Loca marker to mark any stop-
offs. 

4. When all locations have been added to the route, click the Calculate button on 
the toolbar to process the route. 

Make sure that you have added all of your locations to the route before processing 
it; transactions are deducted each time you recalculate the route. 

Note: 

5. If you want to create a new route on the map, you can click the Clear button on 
the toolbar to clear the current route from the screen and delete all route and 
mileage information. 

Using Avoided and Preferred Segments 

When creating a route, you may wish to avoid or include particular road segments 
in your route. You can use the Avoid/Prefer Segment feature to do so. 

Using the Avoid/Prefer Segment feature may produce Practical Routes that do not 
conform to the Rand McNally standard for truck usable highways, and, as such, 
may deviate from highway segments which Rand McNally has defined as generally 
suitable for truck travel.  

Note: 
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Creating Avoided and Preferred Segments 

 To avoid or prefer a road segment: 

1. On the map, click on the road segment you want MileMaker to avoid or prefer. 

2. A location label with the name of the road appears. Click on the label with the 
right mouse button. 

3. On the label's drop-down menu, click on one of the following with the left 
mouse button: 

Avoid Segment 

The Avoid Highway Segments dialog box will appear. The highway name and 
coordinates of the avoided highway segment will be listed. Click on OK. The 
avoided segment will appear in red on the map. 

Prefer Segment 

The Prefer Highway Segments dialog box will appear. The highway name and 
coordinates of the preferred highway segment will be listed. Click on OK. The 
preferred segment will appear in green on the map. 

4. Enter locations and process your route as usual. When you calculate the route, 
MileMaker will route around the avoided segment and/or include the preferred 
one. 

The avoided or preferred road segment will remain active for all subsequent routes 
generated until you remove the feature from that segment.  

Note: 

Resetting Avoided or Preferred Segments 

There are two ways to reset avoided and preferred segments: from the Features 
menu or from map labels. 

 To reset segments using the Features menu 

1. On the Features menu, click on either Avoided Segments or Preferred 
Segments. 

2. A dialog box appears with a list of the avoided or preferred segments. 
Highlight the segment you want to reset. 

3. Click on Reset selected segments. 

4. Click on Done. 

 To reset segments using map labels 

1. On the map, click on the segment you want to reset. 
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2. A location label with the name of the road appears. Click on the label with the 
right mouse button. 

3. A list of menu options appears. With the left mouse button click on Avoid 
Segment or Prefer Segment. 

4. In the Segment Selection dialog box, click on Reset to remove the avoid or 
prefer feature from the selected segment. You can also click on Expand to 
expand the avoided or preferred route. 

Note for Network Users: Whenever an individual user sets an avoided or preferred 
segment on the MileMaker map, that segment becomes designated as avoided or 
preferred on all workstations throughout the network.  

Note: 

Printing or Copying a Map 

 To print a map: 

1. Press Print on the toolbar or select Print from the File menu. 

2. The Print dialog box will appear. In the Print field, select Route pack to print 
the entire data file, including maps, or select Current map to print only the map 
that is presently displayed on the screen. 

For more information on printing MileMaker output, see chapter 4.  

 To copy a map to another Windows application: 

1. On the Edit menu, select Copy Map. The map that is presently on your screen 
will be copied to the Windows clipboard. 

2. To bring the map into another Windows application, open that application, 
then go to the Edit menu and click on Paste. 

3. For more information on copying MileMaker output, see chapter 4. 
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Introduction 

When you calculate a mileage or route inquiry, each point-to-point calculation is 
counted as a transaction. For example, a route from Chicago to St. Louis to Denver 
would count as two transactions. Transactions are deducted from your total each 
time you calculate an inquiry. MileMaker monitors your transaction level and 
makes adjustments to it when transactions are used or added. 

Monitoring Transactions 

 To check your available transactions: 

1. From the File menu, select Transactions. 

2. In the Review section of the Transaction Inventory dialog box, note the number 
of remaining transactions (see Figure 6-1). 

3. Click Done or close the dialog box to return to the previous screen. 
 

 

Figure 6-1 
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Adding Transactions 

When you want to add transactions to MileMaker, you will need to contact Rand 
McNally & Company for the required code. 

 To add additional transactions to MileMaker: 

1. From the File menu, select Transactions. 

2. In the Transaction Inventory dialog box (see Figure 6-1), enter the code you 
received from Rand McNally & Company, then click the Add button. The 
system will inform you that the additional transactions have been added to 
your transaction balance. 

3. Click Done or close the dialog box to return to the previous screen. 

Note to Network Users: Only users with administrative rights will be able to add 
transactions. All other users will only be able to view the remaining number of 
transactions. 

Note: 
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Introduction 

You can use MileMaker's Batch option to create a file containing several mileage 
and/or route inquiries. This file can then be processed at a later time. When you 
process the batch input file, all of its routes are calculated and the results output to 
an ASCII file, the batch output file. The batch output file can be read into other 
programs such as spreadsheets, word processors or databases for additional 
processing or printing. 

You can have as many batch input files as you wish, and can edit and execute them 
as often as necessary. This saves you from having to re-enter information for 
frequently processed routes. 

You use the Batch option on the File menu to create a batch input file. You can 
process the batch file from the File menu, or you can issue a command from DOS to 
run the batch program.  

Creating a Batch Input File  

 To set up a batch file: 

1. On the File menu, click on Batch:Setup. 

2. In the Batch Input File - Batch.in dialog box (Figure 7-1), click on Add to open 
the Batch Inquiry dialog box. 

 

 

Figure 7-1 

3. In the Batch Inquiry dialog box, select a route or mileage inquiry in the Inquiry 
Type section.  

 

60 Chapter 7 - Processing Batch Inquiries 



 

 

Figure 7-2 

4. Enter your route list and specify any customization options, such as distance 
units and/or toll road bias. 

5. Click on Done. This action returns you to the Batch Input File - Batch.in dialog 
box. The inquiry you have created will appear in the Batch Requests list box. 

 

 

Figure 7-3 

6. To create and include another inquiry in the current batch file click on Add 
again. Continue to add inquiries until the batch file is complete. 

7. In the Input File Name field, enter a name for the file. 
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8. Click on Done to save the file under the name you have provided in the Input 
File Name field and exit the dialog box. Click on Save if you want to save the 
file but remain in the dialog box to create another batch input file. Batch input 
files are stored in the MileMaker directory on your hard drive. MileMaker will 
ask if you want to save changes to the existing batch file. Click on Yes to save 
the changes, or click on No to abandon the data you have entered.  
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Processing a Batch File 

 To process a batch file from the File menu: 

1. Click Batch Process on the toolbar, or on the File menu, select Batch:Process. 

2. In the Batch Process dialog box Input File field, type in the name of the batch 
file you want to process. You can click on Browse to see a list of available 
files. 

 

 

Figure 7-4 

3. In the Output File text box, type in a name for the file in which the output from 
the batch inquiries will be stored. 

4. Click on OK to start the batch process. MileMaker will display a message when 
the batch processing is complete. 
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Other Batch File Options 

Once you have created one or more batch input files, you can use the following 
options in the Batch Input File - Batch.in dialog box to manage and edit them. 
 

 

Figure 7-5 

Open 

Use to open an existing batch input file that you want to edit, delete or rename. 

Save 

Use to save a batch input file you have created. This option saves the file, but leaves 
the dialog box open so that you can create another batch input file. The Done button 
saves the file and exits the dialog box.  

Save As 

Use to save an existing batch input file under another file name. 

Change 

Use to edit a route that has been entered into the open batch input file. Highlight the 
route you want to edit. Change opens the route inquiry dialog box where you can 
edit the route as required. 

Delete 

Use to delete a route from a batch input file. Highlight the route you want to delete 
then press the Delete button. 
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Delete All 

Use to delete all of the routes in the open batch input file. You can then use the Add 
button to add new routes. 
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Batch Record Formats 

Use the batch record formats in this section to interpret your output files or to create 
batch input files without using MileMaker. 

Description of All Request Types 

Inquiry Type 
MI: HHG Mileage Inquiry 

MD: Single Origin Multiple Destination Inquiry 

HA: HHG Audit Route Inquiry 

HB: HHG Full Route with State Mileage Breakdown 

HS: HHG State Mileage Breakdown Only Inquiry 

PR: Practical Route Only Inquiry 

PS: Practical State Mileage Breakdown Only Inquiry 

PB: Practical Route with State Mileage Breakdown Inquiry 

PM: Practical Miles Only Inquiry 
 

Request File Record Types 

The request file contains four types of 24-byte Records: the Header Record, the 
Origin Record, the Via Record, and the Destination Record. 
 

Record sequence for a request 
 

 
Record Name 

Character
s  
in Cols 1-2 

 
Explanation 

Header  
Record 

HR This record contains the type of request. In 
addition it can contain user specified information 
which will be passed back to the output file. 

Optimization Record OP This record tells MileMaker SP32 to optimize the 
request. This record, if present, follows the Header 
Record. 

Origin Record OR This record contains the starting point of the trip. 

Via Record VI This record contains the intermediate stop-off 
point (optional). 

Destination Record DT This record contains the final stopping point of the 
trip. 
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Header Record 

The Header Record is used to tell MileMaker SP32 the type of request being sent. In 
addition, the optional user specified information can also be used to separate 
requests and specify information supplied by the user. For example, if you wish to 
keep a trip number, driver number, or bill of lading number attached to the request, 
simply put this information into columns 7-24 of the Header Record. All non-
occupied positions in all fields should contain spaces. If the entire user specified 
information is not used, the remainder of the field must contain spaces. 
 

Record Size: 24 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 HR This field contains “HR” to indicate that this is a 
Header Record. 

3 - 4 2 MI Type of request. One of the following list: MI, 
MD, HA, HS, HB, PR, PS, PM, or PB. See page 
66 for information on the request types. 

5 1 M This field contains an indicator to distinguish 
between distance in miles or kilometers. If the 
indicator is “M” or the field is blank, the distance 
is returned in miles. If the indicator is “K”, the 
distance is in kilometers. Note that kilometer 
requests are only valid for Practical Route options. 

6 1 Space  

7 - 24 18 Info. User supplied information. 

 

Optimization Record 

This record tells MileMaker SP32 to optimize the request. This record, if present, 
follows the Header Record. 
 

Record Size: 24 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 OP This field contains “OP” to indicate that this is an 
Optimization Record. 

3 - 4 2 05 This field indicates what the destination will be. 
In this example, the 5th record will be the 
destination. If there are spaces in this field, the 
program picks the destination. 

5 - 24 20 Spaces  
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Origin Record 

The Origin Record indicates the starting point of the trip. 
 

Record Size: 24 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 OR The “OR” indicates an Origin record. 

3 - 20 18 BARRINGTON City name, SPLC, ZIP Code, or junction. 
If this is an SPLC, the following two fields 
contain spaces. 

21 - 22 2 LA County abbreviation. Field contains spaces 
if a county is not needed. The county code 
is not needed if an SPLC or junction is 
used. 

23 - 24 2 IL State abbreviation. The state code is not 
needed if an SPLC is used. 

 

Via Record 

The Via Record is optional. It is used to indicate a stop-off point in the route. Up to 
26 records may be contained in a request record. In this example, the via point is 
Chicago, IL. 
 

Record Size: 24 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1- 2 2 VI The “VI” indicates that this is a Via record. 

3 - 20 18 CHICAGO City name, SPLC, ZIP Code, or junction.  

21 - 22 2 LA County abbreviation. The county name is not 
needed if an SPLC or junction is used. 

23 - 24 2 IL State abbreviation. The state code is not 
needed for an SPLC. 
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Destination Record 

The Destination Record indicates the destination or final stopping point. In this 
example, the destination is Boston, MA. Note that the last city’s request record must 
be a Destination Record. 
 

Record Size: 24 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 DT The “DT” indicates that this is a Destination 
Record. 

3 - 20 18 BOSTON City name, SPLC, ZIP Code, or junction. 
21 - 22 2  County name abbreviated. It contains spaces if 

a county is not needed. 
23 - 24 2 MA State name abbreviated. 

 

Renamed Locations 

Renamed Locations can be included in your Request file. You must, however, 
specify the record type of the Renamed Location as an Origin, Via, or Destination 
record. (Refer to Description of All Request Types on page 66.) For Renamed 
Locations that are specified as Origin (OR) records, MileMaker SP32 defines the 
first location as the origin and subsequent locations as Via (VI) records. For 
Renamed Locations that are specified as Destination (DT) records, MileMaker SP32 
defines the last location as the destination and preceding locations as Via (VI). The 
total number of locations in a request must not exceed 28. This includes locations 
contained in a Renamed Location. 

Remember that a point-specific Error record contained in the Answer file refers to 
the line number where the error occurred. This includes locations contained in a 
Renamed Location. 
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The Answer File Structure 

The Answer file contains seven types of 71-byte records: Header Record, Mileage 
Inquiry Record, Via Inquiry Record, Detailed Route Record, State Mileage 
Breakdown Record, Error Record, Last Record. 

Record sequence for an answer 

Record 
Name 

Characters 
in Cols 1-2 

 
Explanation 

Header HR This record contains the type of request. It 
can also contain user information that is 
transferred back to the host. 

Mileage Inquiry MI This record contains the origin and 
destination cities. It also contains the total 
toll, total non-toll, and total mileages 
between the origin and destination cities. 

Via Inquiry VI This record contains the intermediate stop-
off point and the mileage from the 
previous point to this stop-off point. 

Detailed Route DR This record contains the detailed 
information on any given segment of a 
trip. 

State Mileage Breakdown SM This record contains the state codes, total 
toll, non-toll, and total mileages per state 
along a route. 

Error ER This record may contain from 1-13 error 
codes if a request cannot be completed. 

Last LR This record indicates the end of the answer 
records for a given request. 
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Header Record 

The Header Record returns the Answer Record type, the request type, the mileage 
indicator, and the optional user specified information. 
 

Record Size: 71 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 HR The Answer Record type “HR” indicates that this 
is a Header Record. 

3 – 4 2 MI Type of request. One of the following list: MI, 
MD, HA, HS, HB, PR, PS, PB, PM. See page 66 
for information on the request types. 

5 1 M This field contains an indicator to distinguish 
between distance in miles or kilometers. If the 
indicator is “M” or the field is blank, the distance 
is returned in miles. If the indicator is “K”, the 
distance is returned in kilometers. Kilometer 
request are only available for Practical Route 
options. 

6 1 Space  

7 - 22 18 Info. User supplied information. 

23 - 71 49 Spaces  
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Mileage Record 

This record follows the Header Record for all inquiry types. Single Origin Multiple 
Destination Inquiries (MD) will contain multiple records. 
 

Record Size: 71 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 MI The Answer Record type “MI” indicates 
that this is a Mileage Record. 

3 - 20 18 BARRINGTON Origin city. 

21 - 22 2 LA Origin county. This field will contain 
spaces if a county code is not needed. 

23 - 24 2 IL Origin state. 

25 - 42 18 CHICAGO Destination city. 

43 - 44 2  Destination county. This field will 
contain spaces if a county code is not 
needed. 

45 - 46 2 IL Destination state. 

47 - 51 5 00018 Total mileage between origin and 
destination points. This field will contain 
zeros if the request type is MI, MD, or 
HA. 

52 - 58 5 00005 Total toll miles or kilometers between 
origin and destination points. This field 
will contain zeros if the request type is 
MI, MD, or HA. 

59 - 65 5 00013 Total non-toll miles or kilometers 
between origin and destination points. 
This field will contain zeros for request 
types MI, MD, or HA. 

66 - 71 6 Spaces  
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Via Record 

The Via Record contains the name of an intermediate stop-off point, as well as the 
mileage from the previous point (either the origin or the previous stop-off point) to 
this stop-off point. In this example, the Via city is New York, NY. This type of 
record will only be returned for an HHG Mileage Inquiry (MI). 
 

Record Size: 71 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 VI The Answer Record type “VI” indicates that 
this is a Via Record. 

3 - 20 18 NEW YORK Via city name. 

21 - 22 2 Spaces Via city county name. This field will contain 
spaces if a county code is not needed. 

23 - 24 2 NY Via state name (abbreviated). 

25 - 31 7 00898 Mileage from previous via city or origin city. 

32 - 71 40 Spaces  
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Route Record 

The Route Record contains the detailed route information for a single segment of a 
route. This type of record will be returned for the following request inquiries: HHG 
Audit Route (HA), HHG Full Route with State Mileage Breakdown (HB), Practical 
Route Only (PR), and Practical Route with State Mileage Breakdown (PB). The 
following is an example of a segment of an answer record. 
 

Record Size: 71 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 DR The Answer Record type “DR” indicates that 
this is a Detailed Route Record. 

3 - 19 17 I 90 This contains the highway segment’s name. 

20 - 21 2 SE Direction of travel on the highway segment. 

22 - 27 6 290 Miles or kilometers traveled on the highway 
segment. 

28 - 54 27 CHICAGO,IL End location on the highway segment. 

55 - 60 6 08:00 Total accumulated time to the end of the 
highway segment from the origin city. This 
field contains spaces for all HHG inquiries. 
HHG inquiries are strictly based on mileages. 

61 - 65 5 450 Total accumulated miles or kilometers to the 
end of the highway segment from the origin 
city.  

66-71 6 TB Highway notes such as HHG INDEX 
mileage, toll roads (TL), toll booths (TB), 
ferries (FY), via (VIA), etc. 
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State Mileage Breakdown Record 

This record contains state codes in alphabetical order and the total mileage for each 
state along the route. This type of record will only be sent for the following request 
inquiries: HHG State Mileage Breakdown Only (HS), HHG Full Route with State 
Mileage Breakdown (HB), Practical State Mileage Breakdown Only (PS), and 
Practical Route with State Mileage Breakdown (PB). In this example, the origin is 
Jackson, MS, and the destination is Charleston, SC. 
 

Record Size: 71 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 SM The Answer Record type “SM” indicates that this 
is a State Mileage Breakdown record. 

3 - 4 2 AL State code for first state alphabetically in the route. 

5 - 9 5 000217 Total miles or kilometers for the first state. 

10 - 16 7 00000.0 Total toll miles or kilometers for the first state. 

17 - 23 7 00217.0 Total non-toll miles or kilometers for the first 
state. 

24 - 25 2 GA State code for the second state alphabetically in the 
route. 

26 - 30 5 00275 Total miles or kilometers for the second state. 

31 - 37 7 00000.0 Total toll miles or kilometers for the second state. 

38 - 44 7 00275.0 Total non-toll miles or kilometers for the second 
state. 

45 - 46 2 MS State code for third state alphabetically in the 
route. 

47 - 51 5 00109 Total miles or kilometers for the third state. 

52 - 58 7 00000.0 Total toll miles or kilometers for the third state. 

59 - 65 7 00109.0 Total non-toll miles or kilometers for the third 
state. 

66 - 71 6 Spaces  

If the route travels through more than three states, the Answer Records will contain 
as many State Mileage Breakdown Records as necessary to show all mileages in all 
states. 
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Error Record 

The Error Record is sent when an error occurs for the current inquiry. Each Error 
Record may contain up to 13 errors. If a request contains fewer than 13 errors, 
the remaining error code fields will contain spaces. 
 

Record Size: 71 bytes 
 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 ER The Answer Record type “ER” indicates that this 
is an Error Record. 

3 - 4 2 02 A number corresponding to a set of possible error 
codes. See page 83 for a list of Error messages 
and explanations. In this example, the error code 
02 indicates that the location could not be found. 
If no error exists, this field will contain spaces. 

5 – 6 2 17 This field indicates the line number where the 
error occurred. If this is a general error message 
however, the field will contain 00 (zeros). If no 
error exists, this field will contain spaces. 

7 1 Space  

8 – 9 2 08 Error code 08.

10 – 11 2 00 General error code 00. 
12 1 Space  

13 – 14 2 04 Error code 04.

15 – 16 2 14 The error occurred on line 14. 
17 1 Space  

18 – 19 2 09 Error code 09.

20 – 21 2 00 General error code 00. 
22 1 Space  

23 – 24 2 03 Error code 03.

25 – 26 2 19 The error occurred on line 19. 
27 1 Space  

28 – 29 2 02 Error code 02.

30 – 31 2 26 The error occurred on line 26. 
32 1 Space  

33 – 34 2 11 Error code 11.

35 – 36 2 00 General error code 00. 
37 1 Space  

38 – 39 2 01 Error code 01.
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40 – 41 2 28 The error occurred on line 28. 
42 1 Space  

43 – 46 4 Spaces Error code or spaces. 
47 1 Space  

48 – 51 4 Spaces Error code or spaces. 
52 1 Space  

53 – 56 4 Spaces Error code or spaces. 
57 1 Space  

58 – 61 4 Spaces Error code or spaces. 
62 1 Space  

63 - 66 4 Spaces Error code or spaces. 
67 1 Space  

68 – 71 4 Spaces Error code or spaces. 
 

Last Record 

This record is the final record for a given request in the answer file. It is used to 
indicate the end of information for the request inquiry. 

 
Cols. 

Number of 
Characters 

Sample  
Content 

 
Explanation 

1 - 2 2 LR The Answer Record type “LR” indicates that this 
is the Last Record. 

3 - 71 69 Spaces  
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Request/Answer Examples 

HHG Mileage Inquiry 

Request 
HRMI DRIVER:  TOM SMITH 

ORCHICAGO             IL 

VIOAK PARK            IL 

VIBARRINGTON        COIL 

DTROSEMONT          COIL 

 

Answer 
HRMI DRIVER:  TOM SMITH 

MICHICAGO           ILROSEMONT      COIL  66 

VIOAK PK            IL     17 

VIBARRINGTON      COIL     29 

VIROSEMONT        COIL     20 

LR 

 

Single Origin Multiple Destination Inquiry 

Request 
HRMD DRIVER:  TOM SMITH 

ORCHICAGO             IL 

VIOAK PARK            IL 

VIROSEMONT          COIL 

DTBARRINGTON        COIL 

 

Answer 
HRMD DRIVER:  TOM SMITH 

MICHICAGO           ILOAK PK        IL   17 

MICHICAGO           ILROSEMONT    COIL   14 

MICHICAGO           ILBARRINGTON  COIL   34 

LR 
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HHG Audit Route Inquiry 

Request 
HRHA DRIVER:  TOM SMITH 

ORCHICAGO             IL 

VIMEMPHIS             TN 

DTWEST MEMPHIS        AR 

 
Answer 
HRHA DRIVER:  TOM SMITH 

MICHICAGO            ILW MEMPHIS     AR  540 

DRCHICAGO            IL532MEMPHIS,TN          532HHG  

DRUS  51        N    0N OF MEMPHIS,TN         532 

DRI   40        W    5E OF W MEMPHIS,AR       537 

DRUS  70        W    3W MEMPHIS,AR            540 

LR 

 On an HHG Audit Route Inquiry, the detail route line information consists of the 
summarization line, such as the first "DR" record above, for routes between HHG 
Key Points. Please note that on this type of inquiry the field containing total 
accumulated time contains all spaces. 

Note: 

HHG State Mileage Breakdown Only Inquiry 

Request 
 
HRHS DRIVER:  TOM SMITH 

ORCHICAGO             IL 

VIDETROIT             MI 

VITORONTO             ON 

VIGARY                IN 

DTCOLUMBIA            MO 

 

Answer 
HRHS DRIVER:  TOM SMITH 

MICHICAGO         ILCOLUMBIA       MO01353  31  1322 

SMIL  290   13  277IN   90  14   76MI  525   2   523 

SMM    98    0   98ON  350   2  348 

LR 
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Practical Route Only inquiry 

Request 
HRPR DRIVER:  TOM SMITH 

ORCHICAGO             IL 

VIOAK PARK            IL 

VIROSEMONT          COIL 

DTBARRINGTON        COIL 

Answer 
HRPR DRIVER:  TOM SMITH 

MICHICAGO        ILBARRINGTON       COIL  48  7  41 

DRI  90     W   11W OF JEFFERSON PK,IL    0:19   11 

DRIL 43     S    6OAK PK,IL               0:35   17 

DRIL 43     N    6W OF JEFFERSON PK,IL    0:51   23 

DRIL 72     W    3ROSEMONT,CO,IL          0:57   26 

DRIL 72     W    2NW OF ROSEMONT,CO,IL    1:01   28 

DRI  90     W    7S OF ROLLING MDWS,IL    1:10   35TL 

DRIL 53     N    4SE OF PALATINE,IL       1:15   39 

DRUS 14     W    8BARRINGTON,CO,IL        1:30   47 

DRIL 59     S    1BARRINGTON,CO,IL        1:33   48 

LR 

Practical State Mileage Breakdown Only Inquiry 

Request 
HRPS DRIVER:  TOM SMITH 

ORCHICAGO             IL 

VIDETROIT             MI 

VITORONTO             ON 

VIGARY                IN 

DTCOLUMBIA            MO 

 

Answer 
HRPS DRIVER:  TOM SMITH 

MICHICAGO          ILCOLUMBIA    MO   1439  18  1421 

SMIL  313   5   308IN   90   7   83MI  433   2   431 

SMMO  123   0   123ON  480   4  476 

LR 
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Practical Route with State Mileage Breakdown Inquiry 

Request 
HRPB DRIVER:  TOM SMITH 

ORCHICAGO             IL 

VIOAK PARK            IL 

VIROSEMONT          COIL 

DTBARRINGTON        COIL 

 

Answer 
HRPB DRIVER:  TOM SMITH 

MICHICAGO        ILBARRINGTON       COIL  48  7  41 

DRI  90     W   11W OF JEFFERSON PK,IL    0:19   11 

DRIL 43     S    6OAK PK,IL               0:35   17 

DRIL 43     N    6W OF JEFFERSON PK,IL    0:51   23 

DRIL 72     W    3ROSEMONT,CO,IL          0:57   26 

DRIL 72     W    2NW OF ROSEMONT,CO,IL    1:01   28 

DRI  90     W    7S OF ROLLING MDWS,IL    1:10   35TL 

DRIL 53     N    4SE OF PALATINE,IL       1:15   39 

DRUS 14     W    8BARRINGTON,CO,IL        1:30   47 

DRIL 59     S    1BARRINGTON,CO,IL        1:33   48 

SMIL 48  7    41 

LR 
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Practical Route in Kilometers 

Request 
HRPBK DRIVER:  TOM SMITH 

ORMONTREAL             PQ 

DTSUDBURY              ON 

 

Answer 
HRPBK DRIVER:  TOM SMITH 

MIMONTREAL PQSUDBURY  ON  700   4.8   695.5 

DRP         138   SW   4.8S OF WESTMOUNT,PQ       0:11  5 

DRAUTORTE   15    NW   6.4SE OF ST LAURENT,IL,PQ  0:15  11TL 

DRAUTORTE   40     W  70.8N OF PTE FORTUNE,ON     1:02   23 

DRTRANS-CAN 417   NW  11.2SE OF HAWKESBURY,ON     1:09   26 

DRP         417    W 106.2NE OF OTTAWA,ON         2:18  200 

DRTRANS-CAN 417   SW  32.2SW OF KANATA,ON         2:39  232  

DRTRANS-CAN 17    NW 338.1E OF N BAY,ON           6:55  570 

DRTRANS-CAN 11-17  W   6.4N OF N BAY,ON           7:00  576 

DRTRANS-CAN 17     W 123.9 SUDBURY,ON             8:36  700 

SMON 618  0.0  618.2PQ   82    4.8   77.3 

LR 
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ERROR CODES 

The error codes supplied in the output file are classified as two distinct types; the 
first type identifies errors with regard to a specific point and its location (line 
number) within an inquiry; the second type identifies general error messages 
pertaining to the entire inquiry. An incorrect spelling of a city name and the line 
number on which it occurred is an example of an error identified in the first 
category of error types, whereas an unavailable option request is an example of an 
error identified in the second category of error types. 

The error code field is four characters in length; the first two characters are the error 
code; the last two characters indicate the line number where the error occurred. 

 
Error 
Code 

 
Error Message 

 
Example 

 
Explanation of Example 

01 Invalid Request Type 0100 The first two characters indicate an 
error code 01, “Invalid Request 
Type.” The last two characters 
indicate a general error code 00. 

02 Location Not Found 0218 The first two characters indicate an 
error code 02, “Location Not 
Found.” The last two characters 
indicate that the error occurred on 
line 18. 

03 State Not Found 0323 The first two characters indicate an 
error code 03, “State Not Found.” 
The last two characters indicate 
that the error occurred on line 23. 

04 County Qualifier 
Required 

0417 The first two characters indicate an 
error code 04, “County Qualifier 
Required.” The last two characters 
indicate that the error occurred on 
line 17. 

05 Route Error 0500 The first two characters indicate an 
error code 05, “Route Error.” The 
last two characters indicate a 
general error code 00. 

06 Secondary Point Error 0600 The first two characters indicate an 
error code 06, “Secondary Point 
Error.” The last two characters 
indicate a general error code 00. 

07 Calc Point Error 0700 The first two characters indicate an 
error code 07, “Calc Point Error.” 
The last two characters indicate a 
general error code 00. 
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Error 
Code 

 
Error Message 

 
Example 

 
Explanation of Example 

08 Kilometers Not 
Available on HHG 
Inquiries 

0800 The first two characters indicate an 
error code 08, “Kilometers Not 
Available on HHG Inquiries.” The 
last two characters indicate a 
general error code 00. 

10 Same Location on 
Consecutive Lines Is 
Invalid 

1014 The first two characters indicate an 
error code 10, “Same Location on 
Consecutive Lines Is Invalid.” The 
last two characters indicate that the 
error occurred on line 14. 

11 Invalid Character 1119 The first two characters indicate an 
error code 11, “Invalid Character.” 
The last two characters indicate 
that the error occurred on line 19. 

12 Invalid Entry-Data Must 
Be a City/County/State, 
Junction or SPLC 

1211 The first two characters indicate an 
error code 12, “Invalid Entry-Data 
Must Be a City/County/State, 
Junction or SPLC.” The last two 
characters indicate that the error 
occurred on line 11. 

13 SPLC Not Found 1317 The first two characters indicate an 
error code 13, “SPLC Not Found.” 
The last two characters indicate 
that the error occurred on line 17. 

14 Unable to Calc Correctly 1426 The first two characters indicate an 
error code 14, “Unable to Calc 
Correctly.” The last two characters 
indicate that the error occurred on 
line 26. 

15 Bad Long/Lat 1500 The first two characters indicate an 
error code 15, “Bad Long/Lat.” 
The last two characters indicate a 
general error code 00. 

16 Unexpected End of 
Batch File 

1600 The first two characters indicate an 
error code 16, “Unexpected End of 
Batch File.” The last two 
characters indicate a general error 
code 00. 

17 Memory Limit 
Exceeded: Separate 
Route into Two Routes:  

1700 The first two characters indicate an 
error code 17 “No Space in 
Memory For Data.” The last two 
characters indicate a general error 
code 00. 
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Error 
Code 

 
Error Message 

 
Example 

 
Explanation of Example 

18 One Origin and One 
Destination Are 
Required 

1800 The first two characters indicate an 
error code 18, “One Origin and 
One Destination Are Required.” 
The last two characters indicate a 
general error code 00. 

19 Insufficient Memory for 
Route 

1900 The first two characters indicate an 
error code 19, “Insufficient 
Memory for Route.” The last two 
characters indicate a general error 
code 00. 

20 Unable to Complete 
Route Error 

2000 The first two characters indicate an 
error code 20 “Unable to Complete 
Route Error.” The last two 
characters indicate a general error 
code 00. 

21 Unable to Complete 
Route - Use HHG 
Mileage Option 

2100 The first two characters indicate an 
error code 21, “Unable to 
Complete Route - Use HHG 
Mileage Option.” The last two 
characters indicate a general error 
code 00. 

22 Invalid Corporate Limit 2212 The first two characters indicate an 
error code 22, “Invalid Corporate 
Limit.” The last two characters 
indicate that the error occurred on 
line 12. 

23 Junction Not Valid for 
HHG 

2307 The first two characters indicate an 
error code 23, “Junction Not Valid 
for HHG.” The last two characters 
indicate that the error occurred on 
line 7. 

24 Unable to Process SPLC 
- Contact Rand McNally 

2403 The first two characters indicate an 
error code 24, “Unable to Process 
SPLC - Contact Rand McNally.” 
The last two characters indicate 
that the error occurred on line 3. 

25 Option Not Available 2500 The first two characters indicate an 
error code 25, “Option Not 
Available.” The last two characters 
indicate a general error code 00. 

28 No More Than 500 
Locations Can Be 
Entered 

2800 The first two characters indicate an 
error code 28, “No More Than 500 
Locations Can Be Entered.” The 
last two characters indicate a 
general error code 00. 
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Error 
Code 

 
Error Message 

 
Example 

 
Explanation of Example 

29 Incorrect Record Type 2900 The first two characters indicate an 
error code 29, “Incorrect Record 
Type.” The last two characters 
indicate a general error code 00. 

30 Renamed Location 
Not Found 

3012 The first two characters indicate an 
error code 30, “Renamed Location 
Not Found.” The last two 
characters indicate that the error 
occurred on line 12. 

70 No More Than 50 
Locations Can Be 
Optimized 

7000 The first two characters indicate an 
error code 70, “No More Than 50 
Locations Can Be Optimized.” 
The last two characters indicate a 
general error code 00. 

71 Invalid Optimization 
Destination 

7100 The first two characters indicate an 
error code 71, “Invalid 
Optimization Destination.” The 
last two characters indicate a 
general error code 00. 

72 Optimizer Error 7200 The first two characters indicate an 
error code 72, “Optimizer Error.” 
The last two characters indicate a 
general error code 00. 

73 Optimization Requires 
no Duplicate Locations 

7300 The first two characters indicate an 
error code 73, “Optimization 
Requires no Duplicate Locations.” 
The last two characters indicate a 
general error code 00. 

74 ZIP Code Unassigned by 
U.S. Post Office  

7400 The first two characters indicate an 
error code 74, “ZIP Code 
Unassigned by U.S. Post Office.” 
The last two characters indicate a 
general error code 00. 

79 Multiple Locations for 
ZIP Code 

7903 The first two characters indicate an 
error code 79, "Multiple Locations 
for ZIP Code." The last two 
characters indicate that the error 
occurred on line 3. 

80 Total Mileage Limit 
Exceeded: Separate into 
2 Routes 

8012 The first two characters indicate an 
error code 80, “Total Mileage 
Limit Exceeded: Separate into 2 
Routes.” The last two characters 
indicate that the error occurred on 
line 12. 
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Error 
Code 

 
Error Message 

 
Example 

 
Explanation of Example 

81 Total Kilometer Limit 
Exceeded: Separate into 
2 Routes 

 

8113 The first two characters indicate an 
error code 81, “Total Kilometer 
Limit Exceeded: Separate into 2 
Routes.” The last two characters 
indicate that the error occurred on 
line 13. 

82 Latitudes and Longitudes 
Valid for MileMaker 
Practical Only 

8204 The first two characters indicate an 
error code 82, "Latitudes and 
Longitudes Valid for MileMaker 
Practical, Only." The last two 
characters indicate that the error 
occurred on line 4. 

83 Invalid Latitude and 
Longitude 

8305 The first two characters indicate an 
error code 83, "Invalid Latitude 
and Longitude." The last two 
characters indicate that the error 
occurred on line 5.  

 



 

88 Chapter 7 - Processing Batch Inquiries 

 

 



 

ADDITIONAL FEATURES Chapter 

8 
Chapter 8 – Additional Features 

Chapter Contents 
ROUTE OUTPUT MAINTENANCE ............................................................................................90 
UPDATE VIA INTERNET ..........................................................................................................91 

Download Updates ..............................................................................................................91 
View Download History.......................................................................................................92 

 

MileMaker SP32 User Guide 89 



 

Route Output Maintenance 

The Route Output Maintenance feature allows you to instruct the MileMaker 
program to write an output file in batch format every time you retrieve a mileage or 
route. It is designed for certain very high volume MileMaker users. In most cases, 
you are better off using the Batch option on the file menu to create batch files. 

 To use the Route Output Maintenance feature: 

1. On the Features menu, select Route Output Maintenance. 

2. In the Route Output Options dialog box, select an output file option: 
 

 

Figure 8-1 

Do NOT write output to a file 

This is the default setting; no output file is created. 

Always overwrite the same file 

After selecting this option, type in the directory, file name, and file extension. 
This same file will be used each time an inquiry is processed. 

Note to Network Users: The name of the file is unique to each workstation. Note: 

Use Sequential number as a file name 

MileMaker will write to a file name that is a sequential number with an 
extension provided by the user. Each time you process an inquiry, MileMaker 
will increment that sequential number by 1.  
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• Use the Reset button in this option to reset the sequential number to zero. 
Resetting will erase all of the files with the specified extension and a 
name starting from zero to the last number used from the default 
directory. If you want to save the files, you can rename them or move 
them to a different directory. 

Note to Network Users: The default directory is unique for each user. Note: 

3. Click on OK to accept the specified option. 

Update via Internet 

The Update via Internet feature provides a means of downloading data and other 
updates from the Internet, and a means of viewing the download history log.  

Download Updates 

The Download Updates feature provides a means of downloading data and other 
updates from the Internet. When the Update via Internet:Download Updates feature is 
selected you will either receive a message box indicating that all files are presently 
up to date or a dialog box listing available updates. 

 If all files are presently up to date: 

1. After clicking Update via Internet:Download Updates the “All files are presently 
up to date” message box appears. 

2. To exit, click OK. 

 If updates are available: 

1. After clicking Update via Internet:Download Updates the MileMaker SP32 
Updates dialog box appears. 

2. Click the check boxes for the updates you wish to download. 

3. Click Download Updates to begin the download. The dialog displays the 
progress bar to indicate how much data has downloaded. When the download 
completes the “Download from Internet completed. Please close and restart the 
Application to complete the Update process.” message appears. 

4. To exit, click OK. 

Clicking OK returns you to the MileMaker SP32 application. You can continue to 
work without the updates applied. To apply the updates follow the procedure below. 

Note: 
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 To apply the updates: 

1. If MileMaker SP32 is still running, then shutdown MileMaker SP32. On the 
File menu, click Exit. 

2. Restart MileMaker SP32. Click the MileMaker SP32 desktop icon. The 
MileMaker SP32 Update dialog will appear. 

3. Do one of the following: 

• Click OK to start the update process. Once the update process is complete, 
MileMaker SP32 will restart. 

or 

• Click Cancel to start MileMaker SP32 without applying the updates. 

The MileMaker SP32 Update dialog will continue to appear upon restart until the 
updates are applied. 

Note: 

The update installation process will closely resemble the original MileMaker SP32 
installation. 

View Download History 

The View Download History feature provides a means of viewing the download 
history log. When the Update via Internet:View Download History feature is selected 
the download history log containing the update file name, version, size, download 
date, and upload date is displayed. 

 To view the download history log: 

1. Click Update via Internet:View Download History. The MileMaker SP32 Update 
History dialog box appears. 

2. To exit, click Close. 
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Entering location data in an Excel worksheet 

This section describes how to enter locations into an Excel worksheet so that you 
can compute mileages between them. MileMaker mileage formulas will read two 
alternative data formats in an Excel worksheet: you can enter standard MileMaker 
location types into individual worksheet cells or you can enter cities and states in 
separate cells. 

Entering Standard MileMaker Location Types 

You can enter the following types of locations into a single cell of a MileMaker for 
Excel spreadsheet: 

• A city name, a comma, and a state or province code 

• A truck-stop name, a comma, and a state code 

• A junction  

• An SPLC (Standard Point Location Code) 

• A 5-digit U.S. ZIP Code 

For more information on entering these types of locations, see page 21 of this User 
Guide. 
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Figure A-1: Location 
data entered in standard 
MileMaker format 

When your worksheet contains location data entered in this fashion, your formulas 
will refer to each location with a single cell. To compute the HHG mileage between 
Chicago and Louisville with the data shown in Figure A-2, you would enter the 
formula: 

=hhg(a3,a4) 
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Entering Cities and States Separately 

You can also enter cities and states into separate cells of the worksheet. 
 

 

Figure A-2: Location 
data entered in separate 
cells 

When your worksheet contains location data entered in this fashion, your formulas 
will refer to each location with two cells. To compute the HHG mileage between 
Chicago and Louisville with the data shown in Figure A-3, you would enter the 
formula: 

=hhg2(a3,b3,a4,b4) 

If MileMaker SP32 for Microsoft Excel cannot identify a location when computing 
a mileage, a browse screen appears that allows you to search for a valid location. 
For more information 

Note: 
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Calculating Mileages in Microsoft Excel 

You can use MileMaker SP32 for Microsoft Excel to calculate the following types 
of mileages between locations in your worksheet: 

• HHG mileages 

• HHG state mileage breakdowns 

• Practical mileages  

• Practical state mileage breakdowns 

If you want to enter a route with stop-offs, you must calculate the mileage between 
each pair of locations in the route. For example, to calculate mileages for the route 
Chicago, IL to Daytona Beach, FL to Garland, TX you would need to first calculate 
the mileage between Chicago, IL and Daytona Beach FL, then the mileage between 
Daytona Beach, FL and Garland, TX. To get the mileage for the entire route you 
would then total the column containing the individual mileages.  

Note: 

 To enter locations and calculate mileages: 

1. Create a new Microsoft Excel worksheet or open an existing one. 

2. Enter each location that will be used in your mileage calculations, using one of 
the data formats described in the previous section.  

3. Type in a mileage formula in a separate cell (Figure A-4), using one of the 
formulas on page 99. Press Enter to calculate the result. The mileage answer 
will replace the formula in the cell (Figure A-5).  

Each time you calculate a formula, a transaction is deducted from your transaction 
balance. 

Note: 

MileMaker SP32 User Guide 97 



 

 

 

Figure A-3: Excel 
worksheet with mileage 
formula 

 
 

 

Figure A-4: Worksheet 
after mileage formula has 
been calculated 

4. Repeat step 3 to calculate mileages between additional pairs of locations. You 
can enter both HHG and Practical mileage formulas in the same worksheet for 
as many pairs of locations as you wish. 

5. When you have calculated all of the mileages your require, run one of the 
macros provided with MileMaker SP32 for Microsoft Excel to convert the 
formula cells to static mileage numbers. For instructions on using the macros, 
see page 103. 

If you do not convert the formulas with one of these macros, the mileage formulas 
in the file will be recalculated when you re-open the file. These recalculations will 
be subtracted from your transaction balance. 

Note: 

6. Save the worksheet. 

You can open the saved worksheet, which no longer contains mileage formulas, 
with the standard Microsoft Excel program or with MileMaker SP32 for Microsoft 
Excel. 

Note: 
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Mileage Formulas 

Consult the tables in this section for the mileage formulas that you can enter into 
MileMaker SP32 for Microsoft Excel.  

 To select a formula: 

1. Choose the table that corresponds to the type of location data in your 
worksheet.  

• The formulas in the table labeled Standard MileMaker Location Data will 
read locations entered into individual cells.  

• The formulas in the table labeled Cities and States in Separate Cells will 
read city and state data entered into different cells.  

2. Select the row that displays the formulas for the type of mileage you want to 
calculate: 

• HHG: These formulas calculate the HHG mileage between the specified 
origin and destination. 

• HHGsmb: These formulas calculate the HHG mileage traversed in each 
state between an origin and a destination. 

• PRAC: These formulas calculate the Practical mileage between the 
specified origin and destination. 

• PRACsmb: These formulas calculate the Practical mileage traversed in 
each state between an origin and a destination. 

3. Choose either the formula that has the browse feature turned on or the formula 
that disables the browse feature (Browse Feature Off). When the browse 
feature is on, a list of locations appears when the program encounters an 
invalid location in a formula. When the browse feature is turned off, the 
program returns an error value when an invalid location is processed. For more 
information on the browse feature, see page 101. 

 
 

Standard MileMaker Location Data 
 

Browse Feature On Browse Feature Off 

HHG =hhg(a1,a2) =hhgnc(a1,a2) 

HHGsmb =hhgsmb(a1,a2) =hhgsmbnc(a1,a2) 

PRAC =prac(a1,a2) =pracnc(a1,a2) 

PRACsmb =pracsmb(a1,a2) =pracsmbnc(a1,a2) 
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Cities and States in Separate Cells 

 
Browse Feature On Browse Feature Off 

HHG =hhg2(a1,b1,a2,b2) =hhgnc2(a1,b1,a2,b2) 

HHGsmb =hhgsmb2(a1,b1,a2,b2) =hhgsmbnc2(a1,b1,a2,b2) 

PRAC =prac2(a1,b1,a2,b2) =pracnc2(a1,b1,a2,b2) 

PRACsmb =pracsmb2(a1,b1,a2,b2) =pracsmbnc2(a1,b1,a2,b2) 

Editing Formulas in the Microsoft Excel Formula Bar 

You can use the Microsoft Excel Formula Bar to edit the currently selected cell. If 
the cell shows the result of a mileage calculation, the Formula Bar displays the 
formula that was entered into the cell. Thus, if you have calculated a mileage, you 
can still view and edit the mileage formula for that cell in the Formula Bar. 
 

 

Figure A-5: Formula Bar 
showing formula for cell 
B3 

Formula Bar 

 If you use the Formula Bar to change a location in a mileage formula or to change 
the type of mileage calculation, MileMaker SP32 for Microsoft Excel automatically 
recomputes the mileage. Each calculation counts as a new transaction. 

Note: 

 To edit a formula in the Formula Bar: 

1. Highlight the portion of the formula you want to change. 

2. Press the Delete key to delete the highlighted information then enter any new 
information or begin typing the new information, which will automatically 
replace the highlighted material. 

3. Press Enter to enter the new formula into the cell and recalculate the mileage. 
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Using the Browse Feature 

You may have incorrectly entered a location name, or you may have entered a ZIP 
Code that contains multiple locations. When you process a formula that refers to 
one of these types of locations, a browse screen appears (Figure A-7). You must 
select the correct location from the browse screen to complete the mileage 
calculation. You can also replace the value in the worksheet cell with the corrected 
location if you wish.  

If you do not want the browse screen to appear while you are entering data, you can 
disable the browse function.  
 

 

Figure A-6: Sample 
browse screen 

Selecting a Location Entry with the Browse Screen 

 To select a location with the browse screen: 

1. Scroll through the list of locations and highlight the selection you want to use 
in your mileage formula. 

2. If you want to complete the calculation, but leave the cell entry in your 
worksheet unchanged, press the Select button. 
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3. If you want to complete the calculation, and replace the cell entry in your 
worksheet with the selected location, place an “X” in the Replace box by 
clicking on the box, then press the Select button. 

Disabling the Browse Feature 

If you do not want the location list to appear when the program encounters an 
invalid location, you can disable the browse feature. To do so, use one of the 
formulas in the column labeled Browse Feature Off on page 99. The term nc in these 
formulas tells the program to return an error value when it encounters an invalid 
location rather than display the location list. The error values returned by 
MileMaker SP32 for Microsoft Excel are described in the next section. 

Microsoft Excel Error Values 

You may encounter the following error values when using MileMaker SP32 for 
Microsoft Excel. Please consult your Microsoft Excel user manual for detailed 
information on error values.  
 

#DIV/0! Attempting to divide by zero 

#N/A Non-available value 

#NAME? Microsoft Excel did not recognize the name 

#NULL! Invalid intersection of two values 

#NUM! Incorrect use of a number 

#REF! Cell is not valid 

#VALUE! Incorrect argument or operation 

#### Indicates that the column must be wider to display data 

-1 General error code. Check to be sure that you have entered the 
mileage formula correctly. Use the data entry options 
information in this chapter as a reference. 

If you encounter error values when using MileMaker SP32 for Microsoft Excel, 
check to make sure you have: 

• Used valid data entry procedures. For example, five-digit ZIP Codes are valid 
for HHG mileage calculations only. An error value will occur if you try to use 
a ZIP Code as a location point for a Practical mileage calculation. 

• Entered the correct column and row headings for the cells in your formula. 

• Entered the mileage formula correctly. 

Call Rand McNally & Company Technical Support at (800) 234-4069 if you cannot 
find the source of the error value. 
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Data Conversion Formulas 

You may wish to see the city name that corresponds to an SPLC or ZIP Code in 
your worksheet or, conversely, the ZIP Code that corresponds to a city name. 
MileMaker SP32 for Microsoft Excel provides formulas that allow you to convert 
location data from one type to another type.  

 To convert a location type: 

• Enter one of the following formulas in a new cell of the spreadsheet: 
 

=codetocity(a1) Converts the ZIP Code or SPLC code in the designated cell to 
a city name and state. 

=cityzip(a1) Converts the city name in the designated cell to a ZIP Code.  

There is no Browse feature with this function. If multiple 
locations are found for a ZIP Code, the first designated 
location is returned. 

=zipchg(a1,flag) Converts the ZIP Code in the designated cell to its 
corresponding city name or SPLC. Set the flag to “0” to 
convert the ZIP Code to a city name. Set the flag to “1” to 
covert the ZIP Code to an SPLC. 

There is no Browse feature with this function. If multiple 
locations are found for a ZIP Code, the first designated 
location is returned. 

 

Data conversions do not count as transactions.  Note: 
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Saving the Mileage Worksheet 

Before leaving a spreadsheet, make sure that you convert the formulas to permanent 
mileages by running either the SetToManual or Freeze macro on the cells containing 
mileage formulas. If you do not run SetToManual or Freeze, the mileage formulas 
will be recalculated when you re-open the file. These recalculations will be 
subtracted from your transaction balance. 

 To freeze your mileages and save a MileMaker SP32 for Excel worksheet: 

1. Select the worksheet cells containing mileage formulas. You can select and 
freeze multiple formula cells at one time. 

2. On the Tools menu select Macro ∑ Macros. 

3. In the Macro dialog box (Figure A-8), type the macro name, SetToManual or 
Freeze, then press the Run button. 

 

 

Figure A-7: Macro 
dialog box 

• If you use SetToManual, the formulas in the selected cell are automatically 
replaced with the calculated mileages. 

• If you use Freeze, the selected cells are marked when you press the Run 
button. You must then press Enter to actually replace the values in the 
cells.  

4. When all of the formulas have been converted to static values, save the 
worksheet using the standard file save options on the File menu. You can then 
open the worksheet in MileMaker SP32 for Microsoft Excel without 
recalculating the mileages and deducting transactions. You can also open the 
worksheet on any computer with the standard Microsoft Excel program. 
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Monitoring and Adding Transactions 

Each time you calculate a mileage formula in a MileMaker SP32 for Microsoft 
Excel worksheet, a transaction is deducted from your transaction balance. Use the 
Transaction Inventory dialog box to monitor your transaction balance and add 
transactions to the balance. 

• You can access the Transaction Inventory dialog box from inside the main 
MileMaker SP32 program (see page 56).  
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Introduction 

Like other Windows applications, the MileMaker program’s menu bar groups 
related commands and options. When you click on a word in the menu bar, a drop-
down menu appears. Move your cursor to the item in the menu you want, and click 
on it to highlight and activate it. 

Menu Items 

 

File Menu 

New 

Creates a new active window with no mileage or route information. In the title bar, 
MileMaker calls new files Route 1, Route 2, and so on. 

Close 

Closes the active window. 

Print 

Brings up the standard Print dialog box. (See page 41.) 

Print Preview 

Displays the active document the way it will look when it is printed on the currently 
selected printer. 

Print Setup 

Displays the standard Print Setup dialog box in which you can view and change the 
active printer, the printing orientation, and the paper size and source. 

Update via Internet 

Download Updates 
Displays a message box indicating that all files are presently up to date or a 
dialog box where you can download toll cost and other updates from the 
Internet. 
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View Download History 
Displays a dialog box where you can view the download history log containing 
the update file name, version, size, download date, and upload date. 

Transactions 

Displays the Transaction Inventory window in which you can view how many 
transactions are remaining. You can also add transactions from this window. On-
screen instructions for adding transactions are included. (See page 57.) 

LAN Interface 

The LAN Interface allows third party software developers to use routes calculated 
by Rand McNally MileMaker inside their software applications. There can be only 
one LAN Interface running on one Network, so it is available only in administrative 
mode. 

Batch (Map option only) 

Brings up the Batch dialog box that allows you to enter a number of inquiries and 
process them as a group at a later time. (See Chapter 7.) 

Setup 

Brings up the Batch Input File-Batch.in dialog box in which you create and 
add mileage and/or route inquiries to a batch file for later processing. 

Process 

Brings up the Batch Process dialog box in which you retrieve your batch file 
and process it to an output data file, which you name. 

Exit 

Quits MileMaker software and returns you to the Windows main menu screen. 

Edit Menu 

Copy Map (Map Option only) 

Copies the active map to the Windows clipboard for pasting into another Windows 
application. 

Copy Itinerary 

Copies the itinerary for the active file to the Windows clipboard for pasting into 
another Windows application. 

Copy All 

Copies both the map (optional) and the itinerary to the Windows clipboard for 
pasting into another Windows application. 
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View Menu 

Show Status Bar 

When checked, this option displays information in a bar at the bottom of the 
MileMaker window. 

Show Toolbar 

When checked, this option displays the command buttons at the top of the screen. 

Mileages Menu 

HHG Mileage 

Brings up the HHG Inquiry dialog box in which you can retrieve HHG mileages 
between any two points with or without stop-offs along the way. Calculations are 
performed between each pair of locations. The total mileage between the origin and 
destination is also generated. 

HHG Origin  

Brings up the HHG Mileage Inquiry dialog box in which you can retrieve HHG 
mileages from the same origin to multiple destinations. Calculations are performed 
between the origin and each of the destinations that follow. 

Practical Mileage  

Brings up the Practical Mileage Inquiry dialog box in which you can retrieve the 
most time- and fuel-efficient route. These mileages are not calculated according to 
HHG tariff rules. The county where each location resides is also displayed.  

Routes Menu 

Practical Route 

Brings up the Practical Route Inquiry dialog box in which you can retrieve a 
Practical Route (distance in miles or kilometers). Mileages retrieved in Practical 
Routes reflect the most time- and fuel-efficient routes. 

Practical Route with SMB 

Brings up the Practical Route Inquiry dialog box in which you can retrieve a 
Practical Route (distance in miles or kilometers), plus the practical distance (miles 
or kilometers) traveled in each state. 

Practical Route SMB Only 

Brings up the Practical Route Inquiry dialog box in which you can retrieve the 
practical distance (miles or kilometers) traveled in each state along a route. 
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HHG Audit Route 

Brings up the HHG Route Inquiry dialog box in which you can retrieve a shortest 
route which lists the first and last Key Points traversed and provides HHG index 
mileages (if two or more Key Points are traversed). 

HHG Full Route with SMB 

Brings up the HHG Route Inquiry dialog box in which you can retrieve a shortest 
route that provides full route detail even if the route is between Key Points. The 
shortest distance (miles) traveled in each state along the route is also provided.  

HHG Route SMB Only 

Brings up the HHG Route Inquiry dialog box in which you can retrieve the shortest 
distance (miles) traveled in each state along a route. 

Calculate 

Processes the current inquiry. Transactions are deducted from the total each time 
you select Calculate. 

Clear 

Erases the route currently displayed on the map and all route and mileage 
information. 

Map Menu (Map Option only) 

View 

Map Only 

After you generate a map and itinerary for a Practical Route, this selection 
moves the splitter handle to the far left of the screen to hide the itinerary and 
display only the map. 

Itinerary Only 

After you generate a map and itinerary for a Practical Route, this selection 
moves the splitter handle to the far right of the screen to hide the map and 
display only the itinerary. 

Map/Itinerary Split 

After you generate a map and itinerary for a Practical Route, this selection 
restores the default display of the map on the right, the itinerary on the left, and 
the splitter handle down the middle. 

Zoom In 

Zooms in to the next scale level and increases the level of detail in the visible area 
of the map. MileMaker starts out at a scale most appropriate for the map it is 
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showing you, or at the scale necessary to view your route if you choose to Zoom 
Route. There are 10 zoom levels in MileMaker. 

Zoom Out 

Zooms out to the next scale level and decreases the level of detail in the visible area 
of the map. MileMaker starts out at a scale most appropriate for the map it is 
showing you, or at the scale necessary to view your route if you choose to Zoom 
Route. There are 10 zoom levels in MileMaker. 

Zoom Route 

Zooms in or out to accommodate the entire generated route in the active window. 

Zoom Region 

Brings up the Zoom Region dialog box. On the left, the list box contains regions 
and states in alphabetical order (the states are listed following the regions). Scroll 
through the list box and click on your preferred state or region. As you select a state 
or region, it becomes highlighted on the map. Click on OK, and the map in the 
active window zooms to your preferred region. 

Show Location 

Displays the Show Location dialog box, where you can enter a location and display 
a label for that location on the map. If you have generated a route, you can also 
click on the Origin or Destination button to display those locations on the map. 
Check the Open new window box if you wish to display the selected location in a 
new window. You can also display a mileage/kilometer radius boundary using your 
selected location as the center (base location). When you check the “Display Map in 
Radius of:” check box and specify the distance of the radius (number of miles or 
kilometers) from your base location, the map will display your base location and a 
radius boundary line. 

Undo Zoom 

Undo Zoom takes you back to the previous map view. 

Compass Rose 

Turns the compass on and off. You can click on any of the shaded areas within the 
compass to scroll the map in that direction. The compass is particularly effective for 
moving the map diagonally. 

Locator Map 

Turns the locator map on and off. The locator map is a small map of North America, 
with a dotted line forming a rectangle. The rectangle shows you the extent of your 
current map view. You can move about on the map in the active window by 
dragging the rectangle in the locator map. Additionally, you can reposition the 
locator map window by clicking on its title bar and dragging, and also resize it by 
dragging its borders. 
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Route Markers 

Turns the Route Markers window on and off. The route markers are push-pin 
symbols that you can use to create a route on the map. The green marker designates 
your desired origin. The red marker symbolizes your intended destination. Use the 
blue marker to indicate any stopovers you would like to make. Click and drag any 
of these markers and drop them on your map. Then click on the Calculate button on 
the toolbar to generate your route. 

Scale 

Turn the scale bar on and off. The scale shows distances in miles relative to the map 
in the active window. You may click and drag the scale bars to figure approximate 
distances between points on the map. 

Legend 

Turns the legend on and off. The legend tells you what the symbols on the map 
mean. 

Map Elements 

Brings up the Display Map Elements dialog box, which lists the items that are 
shown on MileMaker’s maps. By default, all items are selected. You can deselect 
items to customize the appearance of your maps. 

Label 

Hide All Labels 

Hides all location markers on the current map. 

Label Route 

Restores the location labels on the current map. 

Reference Menu 

Contact Point Numbers 

Lists the phone numbers of MileMaker Technical Support, key contacts at Rand 
McNally & Company, and other industry contacts. 

Abbreviations 

Lists abbreviations used in the MileMaker program, including: locations 
abbreviation, state and province, and military abbreviations. 
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Features Menu 

Renamed Location(s) (Map Option only)  

Displays the Renamed Location(s) Browse dialog box, which you can use to save a 
route list under a user-specified name or to edit or delete an existing Renamed 
Location. 

Toll Road Bias 

Displays the Toll Road Bias dialog box, which you can use to alter the amount of 
toll road usage in Practical Routes.  

Avoided Segments (Map Option only) 

Displays the Avoided Segments dialog box and provides a list of the highway 
segments you have requested MileMaker to avoid and allows you to reset avoided 
highway segments. 

Preferred Segments (Map Option only) 

Displays the Preferred Segments dialog box and provides a list of the highway 
segments you have requested MileMaker to prefer and allows you to reset preferred 
highway segments.  

Route Output Maintenance 

This feature allows you to instruct the MileMaker program to write an output file in 
the batch format every time you retrieve a mileage or route. It is designed for use by 
certain high transaction volume situations. In most cases, you will want to use the 
Batch selection on the File menu to create and execute batch files.  

Route Processing Options 

Displays the Router Processing Options dialog box. 

Green Band Restrictions 

This feature allows you to turn MileMaker's default Green Band Restrictions 
off for Practical Routes. 

ZIP Code Processing 

This feature allows you to have MileMaker display a default location when a 
ZIP Code that contains multiple locations is entered. If you do not select this 
option, MileMaker will display a Browse list of locations when a multiple-
location ZIP Code is entered.  

Canadian Borders 

This feature allows you to choose to allow MileMaker to traverse the 
U.S./Canadian border in Practical Route calculations. If you do not select this 
option, or if an origin and destination are located in the same country, the 
Practical Route calculation is forced to route in the same country, even if 
traversing a country border made the route quicker and shorter.  
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Zero Miles 

Displays the Zero Miles Processing dialog box, in which you can specify whether 
MileMaker should return a zero mileage or an error message when the same 
location is entered as both the origin and destination in an HHG mileage inquiry. 

Window Menu 

New Window 

Opens a new view of the map in the active window, if optional map graphics are 
included. 

Cascade 

Arranges windows by laying them one over another within the active window. 

Tile 

Arranges windows by stacking them horizontally within the active window. 

Arrange Icons 

Arranges the minimized windows at the bottom of the Main Application window. 

Change Caption 

Brings up the Change Caption dialog box in which you may change the caption of 
the active window. 

Current Window 

Lists currently open windows. Your active window is designated with a check; click 
on another name to make another window your active window. 

Help Menu 

Contents 

Calls up the MileMaker Help system with a table of its contents. 

Search 

Brings up a dialog box in which you may enter a topic and instruct MileMaker to 
search for that topic in its Help system. 

Map (Map Option only) 

Describes in detail the information about MileMaker’s maps and how to use them. 

How to Use Help 

Displays instructions and information about the MileMaker Help system. 
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About MileMaker 

Displays MileMaker copyright information. 

Toolbar Items 

Like other Windows applications, MileMaker’s toolbar consists of buttons that 
provide quick access to frequently used commands and options. 

MileMaker displays the name and function of a button when you point to it with the 
mouse.  
 

 

Brings up the standard Print dialog box from which you can print a hard 
copy of the MileMaker itinerary and/or map .  

 
Brings up the HHG Mileage Inquiry dialog box in which you can 
retrieve HHG mileages between one location and the next in your route 
list.  

 
Brings up the HHG Mileage Inquiry dialog box in which you can 
retrieve HHG mileages between a single origin and multiple 
destinations. Calculations are performed between the origin and each of 
the subsequent locations in the route list.  

 

Brings up the Practical Route Inquiry dialog box in which you can 
retrieve a Practical Route (distance in miles or kilometers). Mileages 
retrieved in Practical Routes reflect the most time- and fuel-efficient 
route.  

 

Brings up the Practical Route Inquiry dialog box in which you can 
retrieve a Practical Route (distance in miles or kilometers), plus the 
Practical distance (miles or kilometers) traveled in each state along a 
route.  

 

Note: 
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(Map Option only) Processes a mileage and or route inquiry when you 
have entered your locations directly on the map.  

 

Erases the route currently displayed on the map and all route and 
mileage data.  

 

(Map Option only) Zooms in to the next scale level and increases the 
level of detail in the visible area of the map. There are 10 zoom levels 
in MileMaker.  

 

(Map Option only) Zooms out to the next scale level and decreases the 
level of detail in the visible area of the map. There are 10 zoom levels 
in MileMaker.  

y) Zooms in or out to display a complete view of the 
active route.  

ou 
rrent 

origin or destination. You can also use this dialog box to display a 

(Map Option only) Brings up the Batch Processing dialog box, which 
you can use to process several stored routes at one time.  

 
mark. Drag the question mark over a MileMaker menu item or button, 
then click to display information from the Help system on that topic. 

 

 

(Map Option onl

 

(Map Option only) Displays the Show Location dialog box, where y
can enter a location you wish to label on the map, or label the cu

user-defined radius boundary line around a specified location.  

 
 

Activates context-sensitive Help and turns your cursor into a question
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General Abbreviations 

General Abbreviations 

Name Abbreviation 

Academy ACAD 

Accounting ACCT 

Activity ACTY 

Administration ADM 

Agency AGCY 

Airport APT 

Ammunition AMMO 

Annex ANX 

Armament ARMT 

Army AR 

ARPT APT 

Arsenal ASNL 

Artillery ARTY 

Automotive AUTO 

Auxiliary AUX 

Aviation AV 

Ballistics BAL 

Barracks BKS 

Base BS 

Battalion BATL 

Bayou BYU 

Beach BCH 

Bend BND 

Bluff BLF 

Bluffs BLFS 

Borough BORO 

Bottom BTM 

Bottoms BTMS 
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General Abbreviations 

Name Abbreviation 

Branch BRCH 

Bridge BRDG 

Brook BRK 

Building BLDG 

Camp CMP 

Center CTR 

Central CTRL 

Centre CTRE 

Chapel CHPL 

Chemical CHEM 

Christian CHR 

Church CH 

Circle CRC 

City CY 

Ciudad CD 

Cliff CLF 

Cliffs CLFS 

College CLG 

Combined COMB 

Command CMD 

Communications COM 

Community CMTY 

Company CPY 

Construction CSTR 

Contract CONT 

Corner CNR 

Corners CNRS 

County CTY 

Court CRT 

Creek CRK 

Crossing XNG 

Crossroad XRD 
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General Abbreviations 

Name Abbreviation 

Crossroads XRDS 

Dam DM 

Dame DM 

Defense DEF 

Department DEPT 

Depot DPT 

Detachment DTCH 

Development DEV 

Directorate DIR 

District DIST 

Division DIV 

Dunes DNS 

E. E 

East E 

Eastern EN 

Education EDUC 

Electronics ELEC 

Element EL 

Engineer EGR 

Engineering ENG 

Engineers EGRS 

Equipment EQPT 

Estacion ESTN 

Estate EST 

Estates ESTS 

Experimental EXP 

Facility FACL 

Falls FLS 

Farm FM 

Farms FMS 

Ferry FRY 

Field FLD 
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General Abbreviations 

Name Abbreviation 

Finance FIN 

Flat FLT 

Flats FLTS 

Flight FLGT 

Ford FRD 

Fork FK 

Forks FKS 

Fort FT 

Freight FRT 

Furnace FRN 

Garden GDN 

Gardens GDNS 

Gate GT 

General GEN 

Glen GLN 

Glenn GLNN 

Government GOVT 

Grand GR 

Great GRT 

Ground GRD 

Grounds GRDS 

Group GRP 

Groves GRVS 

Harbor HBR 

Harbour HBR 

Headquarters HQ 

Heights HTS 

Hill HL 

Hills HLS 

Home HM 

Homes HMS 

Hospital HOSP 
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General Abbreviations 

Name Abbreviation 

House HSE 

Indian IND 

Institute INST 

International INTL 

Island IS 

Junction JCT 

Laboratory LAB 

Lake LK 

Lakes LKS 

Landing LDG 

Left LF 

Lick LCK 

Little LTL 

Location LOC 

Logistics LOG 

Lower LWR 

Maintenance MANT 

Manor MNR 

Marine MAR 

Materials MTLS 

Meadow MDW 

Meadows MDWS 

Medical MED 

Metro MTRO 

Metropolitan MTRO 

Middle MDL 

Mile MI 

Military MIL 

Mill ML 

Mills MLS 

Mines MNS 

Missile MIS 
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General Abbreviations 

Name Abbreviation 

Mound MND 

Mounds MNDS 

Mount MT 

Mountain MTN 

MT. MT 

MTN. MTN 

Municipal MUN 

N. N 

N.P. NP 

Narrows NRWS 

National NATL 

Naval NAV 

Neck NK 

North N 

Northeast NE 

Northwest NW 

Notre NR 

Nuclear NUC 

Ocean OC 

Office OFC 

Ordinance ORD 

Organizational ORG 

Outlying OUT 

Outport OPT 

Park PK 

Pass PS 

Pathology PATH 

Personnel PER 

Pictorial PICT 

Pines PNS 

Place PL 

Plains PLNS 
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General Abbreviations 

Name Abbreviation 

Plant PLT 

Plantation PLTN 

Plaza PLZ 

Point PT 

Pointe PTE 

Port PRT 

Portage PRTG 

Preserve PSRV 

Presidio PRED 

Procurement PROC 

Propulsion PROP 

Proving PRV 

PT. PT 

Publication PUBL 

Quarry QRY 

Range RGE 

Rapids RPDS 

Recruiting RCTG 

Recruitment RCMT 

Region REG 

Regional REGL 

Research RES 

Reservation RSVN 

Reserve RSV 

Ridge RDG 

River RVR 

Rivers RVRS 

Riviere RVRE 

Saint ST 

Sainte STE 

Santa SNTA 

School SCHL 
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General Abbreviations 

Name Abbreviation 

Science SCI 

Seminary SEM 

Services SERV 

Settlement STL 

Shipyard SHYD 

Shopping SHPG 

South S 

Southern SN 

Southwest SW 

Special SPL 

Spring SPR 

Springs SPRS 

Squadron SQDN 

Square SQ 

ST. ST 

Stand STND 

Station STA 

STE. STE 

Stream STRM 

Submarine SUB 

Supply SUPL 

Support SUP 

System SYST 

Tactical TAC 

Technological TECL 

Technology TECH 

Terminal TRM 

Terrace TRRC 

Territory TERR 

Theological THEL 

Theology THEO 

Topography TOPO 
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General Abbreviations 

Name Abbreviation 

Township TWP 

Trace TRC 

Truck TRK 

Training TRNG 

Transportation TRNS 

U.S. US 

United States of America US 

University UNIV 

Upper UPR 

USA US 

Valle VAL 

Valley VLY 

View VW 

Villa VLA 

Village VLG 

Ville VIL 

Warehouse WHSE 

Warfare WARF 

Water WTR 

Waters WTRS 

Weapons WPNS 

Well WL 

Wells WLS 

West W 

Western WN 

White WHT 

Works WKS 

Yard YD 

 



 

State and Province Abbreviations 

United States 

United States State Abbreviations 

Name Abbreviation 

Alabama AL 

Alaska AK 

Arizona AZ 

Arkansas AR 

California CA 

Colorado CO 

Connecticut CT 

Delaware DE 

District of Columbia DC 

Florida FL 

Georgia GA 

Hawaii HI 

Idaho ID 

Illinois IL 

Indiana IN 

Iowa IA 

Kansas KS 

Kentucky KY 

Louisiana LA 

Maine ME 

Maryland MD 

Massachusetts MA 

Michigan MI 

Minnesota MN 

Mississippi MS 

Missouri MO 
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United States State Abbreviations 

Name Abbreviation 

Montana MT 

Nebraska NE 

Nevada NV 

New Hampshire NH 

New Jersey NJ 

New Mexico NM 

New York NY 

North Carolina NC 

North Dakota ND 

Ohio OH 

Oklahoma OK 

Oregon OR 

Pennsylvania PA 

Rhode Island RI 

South Carolina SC 

South Dakota SD 

Tennessee TN 

Texas TX 

Utah UT 

Vermont VT 

Virginia VA 

Washington WA 

West Virginia WV 

Wisconsin WI 

Wyoming WY 

 



 

Puerto Rico 

Puerto Rico Abbreviations 

Name Abbreviation 

Puerto Rico PR 

 

Canadian Provinces 

Canadian Province Abbreviations 

Name Abbreviation 

Alberta AB 

British Columbia BC 

Manitoba MB 

New Brunswick NB 

Newfoundland and Labrador NF/NL 

Nova Scotia NS 

Northwest Territories NT 

Nunavut Territory NU 

Ontario ON 

Prince Edward Island PE 

Quebec QC 

Saskatchewan SK 

Yukon Territory YT 
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Mexican States 

Mexican States Abbreviations 

Name Abbreviation 

Aguascalientes AG 

Baja California BJ 

Baja California Sur BS 

Campeche CP 

Chiapas CH 

Chihuahua CI 

Coahuila de Zargosa CU 

Colima CL 

Distrito Federal DF 

Durango DG 

Estado Mexico EM 

Guanajuato GJ 

Guerrero GR 

Hidalgo HG 

Jalisco JA 

Michoacan MH 

Morelos MR 

Nayarit NA 

Nuevo Leon NL 

Oaxaca OA 

Puebla PU 

Quaretaro QA 

Quintana Roo QR 

San Luis Potosi SL 

Sinaloa SI 

Sonora SO 

Tabasco TA 

Tamaulipas TM 

Tlaxcala TL 
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Mexican States Abbreviations 

Name Abbreviation 

Veracruz Llave VL 

Yucatan YC 

Zacatecas ZT 



 

Military Abbreviations 

Military Abbreviations 

Name Abbreviation 

Air Defense Squadron ADS 

Air Force AF 

Air Force Base AFB 

Air Force Facility AFF 

Air Force Station AFS 

Air National Guard ANG 

Air National Guard Base ANGB 

Air Reserve Base ARB 

Air Reserve Station ARS 

Air Station AS 

Area Maintenance Support Activity AMSA 

Armed Forces ARMF 

Army Air Field AAF 

Army Ammunition Activity AAA 

Army Ammunition Plant AAP 

Army Aviation Support Facility AASF 

Army Depot AD 

Army Engine Plant AEP 

Army Medical Center AMC 

Army Missile Plant AMP 

Army National Guard ARNG 

Army National Guard Training Center ANGTC 

Army National Guard Training Site ANGTS 

Clothing and Textile C&T 

Coast Guard CG 

Coast Guard Air Station CGAS 

Coast Guard Aircraft and Supply Center CGASC 

Coast Guard Base CGB 
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Military Abbreviations 

Name Abbreviation 

Coast Guard District CGD 

Coast Guard Group CGG 

Coast Guard Integrated Support Command CGISC 

Coast Guard Recruit Training Center CGRTC 

Coast Guard Station CGS 

Coast Guard Support Center CGSC 

Coast Guard Training Center CGTC 

Combat Communications Squadron CCS 

Combined Personal Property Shipping Office CPPSO 

Combined Support Maintenance Shop CSMS 

Consolidated/Containerization C/C 

Construction Battalion Center CBC 

Defense Distribution Depot DDD 

Defense Distribution Region West DDRW 

Defense Energy Office DEO 

Defense Fuel Support Point  DFSP 

Defense Mapping Agency DMA 

Defense Subsistence Office DSO 

Defense Subsistence Region DSR 

Directorate of Logistics DOL 

Engineering Division ED 

Fighter Wing FW 

Fleet and Industrial Supply Center FISC 

Fuel Depot FD 

Intra-Fleet Supply Support Operations Team ISSOT 

Joint Personal Property Shipping Office JPPSO 

Major Port Command (or, Medium Port Command) MPC 

Marine Aircraft Group MAG 

Marine Corps MC 

Marine Corps Air Facility MCAF 

Marine Corps Air Station MCAS 

Marine Corps Base MCB 
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Military Abbreviations 

Name Abbreviation 

Marine Corps District MCD 

Marine Corps Logistics Base MCLB 

Marine Corps Recruiting Depot MCRD 

Marine Corps Recruiting Station MCRS 

Marine Corps Reserve Center MCRC 

Marine Corps Reserve Training Center MCRTC 

Marine Ocean Terminal MOT 

Military Traffic Management Command MTMC 

Mission Support Squadron MSS 

Mobilization and Equipment Training Site MATES 

National Aeronautics Space Administration NASA 

National Naval Medical Center NNMC 

Naval Air Engineering Center NAEC 

Naval Air Engineering Station NAES 

Naval Air Facility NAF 

Naval Air Reserve NAR 

Naval Air Station NAS 

Naval Air Warfare Center NAWC 

Naval Amphibious Base NAB 

Naval Ammunition Depot NAD 

Naval Marine Corps Reserve Center NMCRC 

Naval Marine Corps Reserve Training Center NMCRPC 

Naval Auxiliary Air Station NAAS 

Naval Command Control and Ocean Surveillance 
Center 

NCCOSC 

Naval Construction Battalion Center NCBC 

Naval Education Training Center NETC 

Naval Inventory Control Point NICP 

Naval Ordinance Center NOC 

Naval Ordinance Station NOS 

Naval Radio Station NRS 

Naval Recruiting District NRD 
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Military Abbreviations 

Name Abbreviation 

Naval Regional Medical Center NRMC 

Naval Reserve Center NRC 

Naval Station NS 

Naval Submarine Base NSB 

Naval Supply Center NSC 

Naval Supply Corps School NSCS 

Naval Supply Depot NSD 

Naval Surface Weapons Center NSWC 

Naval Training Center NTC 

Naval Training Station NTS 

Naval Undersea Warfare Center NUWC 

Naval Undersea Warfare Engineering Station NUWES 

Naval Underwater Systems Center NUSC 

Naval Weapons Station NWS 

Naval Weapons Support Center NWSC 

Nuclear Rocket Development Station NRD 

Radar Station RS 

Regional Support Command RESCOM 

Research & Development R&D 

Ship Building Conversion and Repair SBCR 

Ship Conversion and Repair SCR 

Ships Parts Control Center SPCC 

Space and Missile S&M 

Space Flight Center SFC 

Supervisor of Shipbuilding, Conversion and Repair SSCR 

Supply Center SC 

Supply Depot SD 

Tactical Airlift Group TAG 

Tactical Aircraft Wing TAW 

Tactical Wing TW 

Tactical Fighter Group TFG 

Tank Automotive Command TACOM 
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Military Abbreviations 

Name Abbreviation 

Training Center TC 

Training Site TS 

Troop Support Activity TSA 

Unit Training and Equipment Site UTES 

United States Air Force USAF 

United States Army USA 

United States Army Corps of Engineers USACE 

United States Army Engineering District USAED 

United States Army Reserve Center USARC 

United States Army Reserve Training Facility USARTF 

United States Marine Corps USMC 

United States Navy USN 

United States Property Fiscal Office USPFO 
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